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Safety

This chapter includes:

O ELECLICAL SATELY oottt ss s s e b a s bbb st bbb s bbb e b st banen 12
O OPErALIONAL SAFELY ..ot ssses s s s ssss s s ssss s s s s s bbb s s s s senses 14
®  MAINTENANCE SAFELY ..ot s s s b s s b ssnses 16
®  PLINEEN SYMIDOIS ...ttt bbb a s s s a b e s bbb s bbb bbb et ba st nes 17

e  Environmental, Health, and Safety Contact Information

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your Xerox
printer.
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Safety

Electrical Safety

This section includes:

GENETAL GUIAEIINES.......eeee ettt bbbt s s bbb ss s bbb aesassses s sseneas 12
POWET COT .ottt sssees e as s ss e s s s s e E AR s b s e sere s 13
EMEIGENCY TUMN Offc.ene ettt sass s s s st st s sess bt bas bbb e bbb s s bbb assbensen 13
LOSEE SAFELY ..oorveriereeeeiireieeeesee ittt st ss s s s s s s se s sesR s s s s s st 13

General Guidelines

‘,i\_ WARNINGS:

e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting
out a part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Turn off the printer when performing these

installations. Disconnect the power cord when removing covers and guards for installing optional

equipment. Except for user-installable options, there are no parts that you can maintain or
service behind these covers.

The following are hazards to your safety:

The power cord is damaged or frayed.

Liquid is spilled into the printer.

The printer is exposed to water.

The printer emits smoke, or the surface is unusually hot.

The printer emits unusual noise or odors.

The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1.
2.
3.

12

Turn off the printer immediately.
Disconnect the power cord from the electrical outlet.
Call an authorized service representative.
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Power Cord

e  Use the power cord supplied with your printer.

e  Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

e Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

& WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

e  Only use an extension cord or power strip designed to handle the electrical current capacity of the
printer.

e  Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

o Do not place the printer in an area where people can step on the power cord.

e Do not place objects on the power cord.

e Do not plug or unplug the power cord while the power switch is in the On position.

e If the power cord becomes frayed or worn, replace it.

e Toavoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Turn Off

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

e  The equipment emits unusual odors or makes unusual noises.

e The power cable is damaged or frayed.

e A wall panel circuit breaker, fuse, or other safety device has been tripped.
e Liquid is spilled into the printer.

e The printer is exposed to water.

e Any part of the printer is damaged.

Laser Safety

This printer complies with laser product performance standards set by governmental, national, and
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous
light because the beam is totally enclosed during all modes of customer operation and maintenance.

WARNING: Use of controls, adjustments, or performance of procedures other than those specified in
this manual can result in hazardous radiation exposure.
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

Operational Guidelines

e Do not remove any paper trays while the printer is printing.

e Do not open the doors when the printer is printing.

e Do not move the printer when it is printing.

e Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

e  Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location
e  Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.
To find the weight for your printer configuration, see Physical Specifications on page 228.

e Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

e  Place the printer in an area where there is adequate space for operation and servicing.

e  Place the printer in a dust-free area.

e Do not store or operate the printer in an extremely hot, cold, or humid environment.

e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

e Do not place the printer where it is directly exposed to the cold air flow from an air conditioning
system.

e Do not place the printer in locations susceptible to vibrations.
e  For optimum performance, use the printer at the elevations specified in Elevation on page 231.
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Safety

Printer Supplies

e Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

e Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.

e  Store all consumables in accordance with the instructions given on the package or container.

e  Keep all consumables away from the reach of children.

e Never throw toner, print/drum cartridges, or toner containers into an open flame.

e  When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can
cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase
the risk of skin or eye contact.

,i\\_ CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Please contact your Xerox representative for details.
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Maintenance Safety

¢ Do not attempt any maintenance procedure that is not specifically described in the documentation
supplied with your printer.

e Do not use aerosol cleaners. Clean with a dry lint-free cloth only.

e Do not burn any consumables or routine maintenance items. For information on Xerox supplies
recycling programs, go to www.xerox.com/gwa.
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Safety

Printer Symbols

Symbol Description

Warning:
A Indicates a hazard which, if not avoided, could result in death or serious injury.

Caution:
Indicates a mandatory action to take in order to avoid damage to the property.

Hot surface on or in the printer. Use caution to avoid personal injury.

Do not burn the item.

Do not expose the imaging unit to light for more than 10 minutes.

O
A
®

@ Warning:

A Wait for the printer to cool for the specified time before touching the fuser.

Do not expose the imaging unit to direct sunlight.

Do not touch the part or area of the printer.

175°C
> 347°F
iZ) 00:40%

et

This item can be recycled. For details, see Recycling and Disposal on page 249.
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Environmental, Health, and Safety Contact
Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies,
contact the following customer help lines:

United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
Europe: +44 1707 353 434

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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Features

This chapter includes:
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Parts of the Printer

This section includes:
O FTONE VIBWiaeetet ettt sttt s st s s st as s b a s s assesasas s s sastesesassesasaesesasseserasassenas
O REAN VIBW ettt sttt sa s s s s st b s et s s A s nn s s s ssnaes
©  INEEINAL PAMES oottt s s sas st s bbbt s bbb e bbbt bbb e s b s e s b s s snen

e  Control Panel

Front View

1. Tray1 Duplex Automatic Document Feeder
2. Bypass Tray Staple Cartridge Door

3. Front Door Output Tray

4.  Output Tray Paper Stop . Front Door Handle

5.  Control Panel 0. Optional 550-Sheet Feeder
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Rear View

o bkwhN=

USB Type B Port
Ethernet Connector
USB Type A Port
USB Type A Port
Power Connector
Rear Door

7. Duplex Unit
8. Transfer Roller

9. Fuser
10. USB Memory Port
11. Fax Line Connector
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Features

Internal Parts

=
=

———

1. Output Tray Paper Stop 6. Document Glass

2.  Front Door 7. Staple Cartridge

3. Toner Cartridges 8. Waste Cartridge Lock
4. Duplex Automatic Document Feeder 9. Imaging Units

5. Document Cover 10. Waste Cartridge
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Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on
the printer. The control panel:

e Displays the current operating status of the printer.

e  Provides access to print features.

e  Provides access to reference materials.

e  Provides access to Tools and Setup menus.

e  Provides access to Troubleshooting menus and videos.

e  Prompts you to load paper, replace supplies, and clear jams.
e Displays errors and warnings.
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Item Name Description
1 E?Supizfcreen The screen displays information, and provides access to printer functions.
2 Services Home This button provides access to printer features, such as copy, scan, and fax, on the touch
Button screen.
. This button returns to the active service from the Job Status or Machine Status screens,
3 Services Button .
or to a preset service.
4 Job Status Button This button displays lists of all active, secure, or completed jobs on the touch screen.
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Item Name Description
5 II;Au(i(EQLne Status This button displays the status of the printer on the touch screen.
6 Alphanumeric The keypad enters alphanumeric information.
Keypad
C (clear) Button This button deletes numeric values or the last digit entered using the alphanumeric keys.
Dial Pause Button This button inserts a pause in a telephone number when it transmits a fax.
Interrupt Button This button pauses the current job to run a more urgent print, copy, or fax job.
10 Start Button This button starts the selected copy, scan, fax, or Print From job, such as Print from USB.
1 Stop Button This buttqn stops. the current job temporarily. To cancel or resume your job, follow the
onscreen instructions.
12 Clear All Button This button clears previous and changed settings for the current selection. To reset all
features to their default settings and clear existing scans, press this button twice.
13 Power Button This button powers up or powers down the printer.
14 Language Button This button changes the touch screen language and keyboard settings.
15 Power Saver button | This button enters and exits the low-power mode.
16 Help Button This button displays information about the current selection on the touch screen.
17 Log In/Out Button This button provides access to password-protected features.
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Information Pages

Your printer has a printable set of information pages stored on its internal hard drive. Information pages
include configuration and font information, demonstration pages, and more.

1. At the printer control panel, press the Machine Status button.

2. On the Machine Information tab, touch Information Pages, then touch the desired information
page.
3. Touch Print.

Note: Information pages can also be printed from CentreWare Internet Services.

Printing the Configuration Report

1. At the printer control panel, press the Machine Status button.
2. On the Machine Information tab, touch Information Pages>Configuration Report>Print.
3. Touch Close after the report prints.
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Administration Features

This section includes:

®  ACCESSING T PrINTON ... oottt sttt senens 26
0 CentreWare INTEINEL SEIVICES ...ttt ss s ssssss s s ssss s s ssssas st s sssssss s sssssnsensnsans 28
o Finding the IP Address Of the PHNTEN ...ttt ssss s sssssssssssssssssssassssssassssnses 29
o AULOMALIC DALA COUECLION ...ttt s b bbbt assasans 29
o Billing and Usage INFOMMOLION ...t sessssstss st ssssssssssssssssssssssssssssssasssssssssssssssssssssssssansssnses 29

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs.

Accessing the Printer

The system administrator can set access rights on the printer to ensure that unauthorized users cannot
access the printer. If the system administrator configures authentication and authorization, users require
a login and password to access some or all of the features of the printer. The administrator can also
configure accounting to require an accounting code to access tracked features.

Authentication

Authentication is the process of confirming your identity. When the system administrator enables

authentication, the printer compares the information that you provide to another source of information,
such as an LDAP directory. The information can be a user name and password, or the information stored
on a magnetic or proximity ID card. If the information is valid, you are considered an authenticated user.

The system administrator can set permissions so that authentication is required when accessing features
at the control panel, in CentreWare Internet Services, or in the print driver.

If the administrator configures local or network authentication, you identify yourself by typing your user
name and password at the control panel or in CentreWare Internet Services. If the administrator
configures card reader authentication, you identify yourself by swiping a magnetic or proximity card at
the control panel and typing a passcode.

Note: The system administrator can allow you to type your user name and password when Smart
Card authentication is the primary authentication method. If the administrator configures an
alternative authentication method, and you misplace your card, you can still access the printer.
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Features

Authorization

Authorization is the function of specifying the features that you are allowed to access, and the process
of approving or disapproving your access. The system administrator can configure the printer to allow
you to access the printer, but restrict your access to certain features, tools, and services. For example, the
printer can allow you access to copying but restrict your access to color printing. The system
administrator can also control your access to features at specific times during the day. For example, the
system administrator can restrict a group of users from printing during peak business hours. If you
attempt to print using a restricted method or during a restricted time, the job does not print. Instead, the
printer prints an error page and the job appears with an error message in the Job Status lists.

Where the system administrator stores the authorization information determines the authorization type.
e Local authorization stores the login information on the printer in the user Information Database.

e Network authorization stores the login information in an external database, such as an LDAP
directory.

The system administrator sets authorization permissions. To set or edit user permissions for access to
printer features, you must log in as the administrator.

Accounting
Accounting monitors the print, copy, scan, and fax impressions produced and who produces them.

The system administrator must create user accounts and enable the accounting feature. When
accounting is enabled, you must log in to the printer before accessing services. You must also provide
your account details in the print driver before printing documents from a computer. The system
administrator can set limits to restrict the total number of jobs by type that a user can produce. The
administrator can also generate reports listing usage data for individual users and groups.

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs.

Logging In

Logging in is the process by which you identify yourself to the printer for authentication. If
authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel
1. At the control panel, either press Log In/Out or touch Guest.

2. If an administrator has configured more than one authentication server, select your domain, realm,
or tree.

a. Touch Domain, Realm, or Tree.
b. From the list, touch your domain, realm, or tree.
c. Touch Save.

3. Type your user name, then touch Next.

4. Type your password, then touch Done.
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Features

Logging In to CentreWare Internet Services
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 29.

At the top of the page, next to the lock and key icon, click Login.
Type the User ID in the space provided.
Type the password in the space provided.

& wN

Click Login.
Administrator Password

The administrator password is required when accessing locked settings in CentreWare Internet Services
or at the control panel. Most printer models have a default configuration that restricts access to some
settings. Access is restricted for settings on the Properties tab in CentreWare Internet Services, and
settings on the Tools tab on the control panel touch screen.

Logging In as the System Administrator at the Control Panel
1. At the control panel, press Log In/Out.

2. Type admin, then touch Next.

3. Type your password, then touch Done.

Note: The system administrator user name is admin and the default password is 1111.

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the
embedded Web server in the printer. It allows you to configure and administer the printer from a Web
browser.

CentreWare Internet Services requires:

e A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

e  TCP/IP and HTTP enabled in the printer.
e A network-connected computer with a Web browser that supports JavaScript.

For details, see the Help in CentreWare Internet Services or the System Administrator Guide.

Accessing CentreWare Internet Services

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press
Enter or Return.
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Finding the IP Address of the Printer

You can view the IP address of your printer on the control panel or on the Configuration Report. On the
Configuration Report, IP address information is located in the Connectivity Protocols section.

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Machine Status button.
2. Touch the Machine Information tab.

—  If the system administrator has set the Display Network Settings to show the IP address, it
appears in the center panel.

— If the IP address is not displayed, print the Configuration Report or contact your system
administrator.

To print a Configuration Report:

1. At the printer control panel, press the Machine Status button.

2. On the Machine Information tab, touch Information Pages>Configuration Report>Print.
3. Touch Close after the report prints.

Automatic Data Collection

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a
designated servicer uses this data to support and service the printer, or for billing, supplies
replenishment, or product improvement. Automatically transmitted data can include product
registration, meter read, supply level, printer configuration and settings, software version, and problem
or fault code data. Xerox cannot read, view, or download the content of your documents residing on or
passing through your printer or any of your information management systems.

To turn off automatic data collection:

On the Welcome page in CentreWare Internet Services, click the link in the note regarding automated
services.

Billing and Usage Information

Billing and printer usage information appears on the Billing Information screen. The impression counts
shown are used for billing.

For details, see Billing and Usage Information on page 183.
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More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Other documentation for your printer

www.xerox.com/office/WC6655docs

Recommended Media List

United States: www.xerox.com/paper
European Union: www.xerox.com/europaper

Technical support information for your printer;
including online technical support, Online Support
Assistant, and driver downloads.

www.xerox.com/office/WC6655support

Information about menus or error messages

Press the control panel Help (?) button.

Information Pages

Print from the control panel, or from CentreWare
Internet Services, click Status>Information Pages.

CentreWare Internet Services documentation

In CentreWare Internet Services, click Help.

Order supplies for your printer

www.xerox.com/office/WC6655supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual
needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

Xerox® Direct online store

www.direct.xerox.com/
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Welcome Center

If you need assistance during or after printer installation, visit the Xerox® website for online solutions
and support at www.xerox.com/office/worldcontacts.

If you require further assistance, contact the Xerox® Welcome Center for the United States and Canada
at 1-800-835-6100.

If a local Xerox representative telephone number was provided during printer installation, record the
telephone number in the following space.

#

If you need additional help using your printer:

1. Refer to this user guide.

2. Contact the system administrator.

3. Visit the Xerox® website at www.xerox.com/office/WC6655support.

To assist you, the Welcome Center needs the following information:
e The nature of the problem.

e The serial number of the printer.

e The fault code.

e The name and location of your company.

Locating the Serial Number

To contact Xerox for assistance, you need the printer serial number. The serial number is located at the
rear of the printer.

To view the serial number at the printer control panel, press the Machine Status button, then touch the
Machine Information tab.
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Installation and Setup

This chapter includes:

o INStallation ANA SELUDP OVEIVIEW. ...t sessssssiss s s ssssssssssssasssssssssssssssssssssssssssssssssssssssssssssssssnses 34
o Selecting @ LOCALION FOI the PrINTEI ...ttt ssss s sssss st sssssssssssssssssnses 35
o Power Cord Safety INFOrMOLION ...t sssssssssssssss s ssssssssssssssssessssssssssssssssssssssssnees 36
®  CONNECHING TN PrINEET oottt ce e s e neeas 37
o Configuring NEtWOTK SEELINGS.....vveveeerrirceeris it sssssssssssssssssssssssssssssssssssssssessssssssssssssssssssessenses 41
®  MOdifYing GENEIAL SETLINGS «...ovvereeeeereerrieee it s s ssse s ssssssss s s st sssa st s s sasss s sssessnses 42
®  INSEAING thE SOFEWAIE ..ottt sttt ss s ss e s s nssas 44
See also:

Installation Guide packaged with your printer.
System Administrator Guide at www.xerox.com/office/WC6655docs.
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Installation and Setup

Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure
the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect over a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to CentreWare
Internet Services.

Note: If the Software and Documentation disc is not available, you can download the latest drivers
from www.xerox.com/office/WC6655drivers.

See also:

Selecting a Location for the Printer on page 35
Choosing a Connection Method on page 37
Connecting the Printer on page 37
Configuring Network Settings on page 41
Installing the Software on page 44
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Installation and Setup

Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 5-32°C (41-90°F), and relative humidity 15-85%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can
cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the
weight for your printer configuration, see Physical Specifications on page 228. Select a location with
adequate clearance to access supplies and to provide proper ventilation. To find the clearance
requirements for your printer, see Clearance Requirements on page 229.

3. After positioning the printer, you are ready to connect it to the power source and computer or
network.
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Power Cord Safety Information

Carefully read the following instructions before operating your printer. For details, contact your Xerox
representative.

A

WARNINGS:

o  The electrical supply for the device must meet the requirements stated on the data plate on the
rear of the device. If you are not sure that your electrical supply meets the requirements, consult
your local electricity provider or a licensed electrician.

e Do not use an extension cord.
e Do not remove or modify the power cord.

Refer to these instructions to ensure the continued safe operation of your printer.

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

Replace the power cord if it becomes frayed or worn.

Do not unplug or plug the power cord while the printer is turned on.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.
The electrical outlet must be near the printer and must be easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.
For details, see Turning the Printer On and Off on page 39.
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Connecting the Printer

This section includes:

Selecting @ CoNNECLION MELNO......... ettt st s s ss st sans 37
Physically Connecting the Printer to the NETWOIK..........eieierieeesiesssssissssse s sssass s sessssssssssesssenees 38
Connecting to a COmMPUEET USING USBi....... ettt ssssssstssssssssssssssssssssssssssssssssssssssssens 38
Connecting t0 A TElEPNONE LINE ...ttt sss s sassssss s sssssssssssssssasssssssessans 38
Turning the Printer ON AN Off ...ttt ssssses s sssssassssssssssssssssssssssssassssssssssssssssssnssssssnns 39

Selecting a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you
select depends on how your computer is connected to the network. A USB connection is a direct
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a
network connection, it is important to understand how your computer is connected to the network. For
details, see About TCP/IP and IP Addresses on page 41.

Notes:

e Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or driver type.

e Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and must be purchased separately.

Network: If your computer is connected to an office network or home network, use an Ethernet
cable to connect the printer to the network. You cannot connect the printer directly to the computer.
It must be connected through a router or hub. An Ethernet network can be used for one or more
computers and supports many printers and systems simultaneously. Ethernet connection is typically
faster than USB and allows you direct access to the settings of the printer using CentreWare
Internet Services.

Wireless Network: If your computer includes a wireless router or wireless access point, you can
connect the printer to the network with a wireless connection. A wireless network connection
provides the same access and services as a wired connection provides. A wireless network
connection is typically faster than USB and allows direct access to the setting of the printer using
CentreWare Internet Services.

USB: If you connect the printer to one computer and do not have a network, use a USB connection.
A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In
addition, a USB connection does not provide access to CentreWare Internet Services.

Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated
telephone line.
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Physically Connecting the Printer to the Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is
used for one or more computers and supports many printers and systems simultaneously. An Ethernet
connection provides direct access to printer settings using CentreWare Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer.
Connect the other end of the Ethernet cable to a correctly configured network port on a hub or
router.

3. Turn on the printer.

Note: For details on configuring wireless network settings, see the System Administrator Guide at
www.xerox.com/office/WC6655docs.

Connecting to a Computer Using USB

To use USB, you must have Windows 7, Windows Server 2003, and later, or Macintosh OS X version 10.7
and later.

To connect the printer to the computer using a USB cable:

1. Ensure that the printer is turned off.

Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer.
Attach the power cord and then plug in the printer and turn it on.

Connect the A end of the USB cable to the USB Port on the computer.

When the Windows Found New Hardware Wizard appears, cancel it.

You are ready to install the print drivers. For details, see Installing the Software on page 44.
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Connecting to a Telephone Line

1. Ensure that the printer is turned off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Enable and configure the Fax functions.

Notes:

e Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or driver type.

e The fax function works best with an analog phone line. Voice-Over Internet Protocols (VOIPs)
such as FIOS and DSL are not supported.

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs.
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Turning the Printer On and Off

This printer has both a power switch and a power button. The power switch on the side of the printer
controls the main power to the printer. The control panel power button controls power to the printer

electronic components. The preferred software-controlled printer shutdown method is to press the power
button.

To turn on the printer:
e Turn on the power switch.

e If the power switch is on, but the printer is powered off, the printer was turned off using the power
button. To turn on the printer, on the control panel, press Power.

To turn off the printer:

/1 CAUTIONS:

e To prevent a printer malfunction or damage to the internal hard drive, perform the
power button shutdown first. After the touch screen goes dark, wait 10 seconds, then
turn off the power switch.

e Do not plug or unplug the power cord while the printer is powered on.
e  Ensure that there are no jobs in the queue.
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1. On the control panel, press Power.

2. Touch Power Down.
After 10 seconds, the touch screen goes dark and the Power Saver button flashes until the printer
has completed powering down.

Note: When all of the control panel lights are off, the printer power off sequence is complete.
Turning the power switch off is optional.
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Configuring Network Settings

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network.
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does
not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server
automatically assigns an IP address to every computer and printer on the network that is configured to
use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.
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Modifying General Settings

You can modify printer settings such as the language, date and time, units of measurement, display
brightness, and startup page from the control panel.

1.
2.

At the printer control panel, press the Machine Status button, then touch the Tools tab.

Touch Device Settings>General, then touch the setting you want to change:

— Energy Saver specifies when the printer goes into energy-saving mode.

— Date and Time allows you to set the time zone, date, time, and display format.

— Language/Keyboard Selection allows you to set the language and keyboard layout.

—  Custom Keyboard Button allows you to assign text to the custom key on the virtual keyboard.
Note: This is a partial list. If a feature does not appear, contact the system administrator or log in as

a system administrator. For details, see Logging In as the System Administrator at the Control Panel
on page 28.

Touch Save.

Setting Energy Saver Mode

You can set the time the printer spends idle in ready mode before the printer transitions to a lower
power level.

To configure Energy Saver settings:

1.
2.
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At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch Device Settings>General>Energy Saver.

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as
the System Administrator at the Control Panel on page 28.

Under From Standby Mode to Energy Saver Mode, to set the time in minutes, touch the arrow
buttons. Standby Mode uses more energy, but wakes faster than Energy Saver Mode.

Under From Energy Saver Mode to Sleep Mode, to set the time in minutes, touch the arrow buttons.
Energy Saver Mode uses more energy, but wakes faster than Sleep Mode.

Touch Save.
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Setting the Date and Time at the Control Panel

1.
2.

At the printer control panel, press the Machine Status button, then touch the Tools tab.

Touch Device Settings>General>Date and Time.

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as
the System Administrator at the Control Panel on page 28.

To set the time zone, touch Time Zone, then touch the arrows to adjust the time zone.

To set the date, touch Date, select a format, then set the date.

To use 24 hour format, select Display 24 hour clock. To set the time, touch Time, then set the time.
Note: The date and time are set automatically through Network Time Protocol (NTP). To modify

these settings, go to the Properties tab in CentreWare Internet Services and change the Date and
Time Setup to Manual (NTP Disabled).

Touch Save.
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Installing the Software

This section includes:

Operating System REQUITEMENTS ...t sssesssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssans 44
Installing Drivers and Utilities fOr WINAOWS ..........iernensiesiessssssssisssisssssesssssssesssssssssssssssssssssssssssssssssans 45
Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and Later........cccovecnneenneeenee 46
Installing Scan Drivers fOr MACINTOSK ...t sssssssssssssssssss s sssssssssssssssssssnes 47
Installing Print Drivers and Utilities for UNIX and LinuxX Printing .....co.cooeeecreeenmeeseceneeseeeseeseeeeeeeeeseeanas 47
OTREE DIIVETS ....cooeeeretrceeeeceieeeeceaseceseessssesssseesssesssesessesssssessasesessssssseses s saese s bs e bbbt sssesaasesssseseanes 49

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If
you cannot find the IP address, see Finding the IP Address of Your Printer on page 29.

If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/office/WC6655drivers.

Operating System Requirements

44

Windows XP SP3, Windows Vista, Windows 7, Windows 8, Windows Server 2003, Windows
Server 2008, Windows Server 2008 R2, and Windows Server 2012.

Macintosh OS X version 10.7 and later.

UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface. For details, see www.xerox.com/office/WC6655drivers.
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Installing Drivers and Utilities for Windows

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:

1.

©® NV EWN

10.
11.

12.

Insert the Software and Documentation disc into the appropriate drive on your computer. The
installer starts automatically.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

To change the language, click Language.

Select your language, then click OK.

Click Install Drivers>Install Print and Scan Drivers.

To accept the license agreement, click I Agree.

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers, click Extended Search.
If your printer still does not appear in the list of discovered printers, and you know the IP address:
a. Click the Network Printer icon at the top of the window.

b. Enter the IP address or the DNS name of the printer.

c. Click Search.

d. From the list of discovered printers, select your printer, then click Next.

If the printer still does not appear in the list of discovered printers, and you do not know the IP
address:

a. Click Advanced Search.

b. If you know the gateway address and subnet mask, click the top button and enter the
addresses into the Gateway and Subnet Mask fields.

c. If you know the address of another printer on the same subnet, click the middle button and
enter the address in the IP Address field.

Click Search.
From the list of discovered printers, select your printer, then click Next.

Note: When the printer appears in the Discovered Printers window, it displays the IP address. Record
the IP address for future use.

Select the desired driver.
Click Install.
If the installer prompts you for the IP address, enter the IP address of the printer.

If the installer prompts you to restart your computer, click Restart to complete the installation of
the drivers.

To complete the installation, click Finish.
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Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and
Later

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:

okt whN-=
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10.
11.

Insert the Software and Documentation disc into the appropriate drive on your computer.
Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.

To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.

When prompted, click Continue.

To accept the license agreement, click I Agree.

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

Enter your password, then click OK.

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c.  Select your printer in the list of discovered printers, then click Continue.
To accept the print queue message, click OK.

Select or clear the Set Printer as Default and Print a Test Page check boxes.
Click Continue, then click Close.

Note: The printer is added automatically to the printer queue in Macintosh OS X versions 10.7 and
later.

To verify the installation of printer options with the print driver:

1.

- whN
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From the Apple menu, click Printer Preferences>Print & Scan.

Select the printer in the list, then click Options and Supplies.

Click Driver, then confirm that your printer is selected.

Confirm that all of the options installed on the printer appear correct.

If you change settings, click OK, close the window, then exit System Preferences.
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Installing Scan Drivers for Macintosh

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
To view the .dmg file for your printer, double-click the disc icon on your desktop.

Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating
system.

Open the Scan Installer package file.

To acknowledge the warning and introductory messages, click Continue.
To accept the license agreement, click Continue, then click Agree.

Click Continue again.

Enter your password, then click OK.

. If prompted to close other installations, click Continue Installing.

0. Torestart, click Log Out.

=0 ® NV

Installing Print Drivers and Utilities for UNIX and Linux Printing

For details about UNIX and Linux drivers, see the System Administrator Guide at
www.xerox.com/office/WC6655docs.

Xerox® Print Driver Package

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux
environments.

Xerox® Print Drivers

You can use a Xerox® print driver to select printer features. All operating systems include the Office
Standard print driver, which can print to a wide range of Xerox devices that share common features. You
can use a Linux-based print driver to print to a specific model.

Xerox® Printer Manager

Xerox® Printer Manager allows you to:
e Configure local and network-connected printers.
e Set up a printer on your network as well as monitor the operation of the printer once installed.

e  Provide a common look and feel across the many different suppliers of UNIX and Linux operating
systems.
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Installing Xerox® Print Driver Package
Before you begin:

Ensure that you have root or superuser privileges to install Xerox® Printer Manager.

Note: When installing drivers for a network printer, if you do not see your printer in the list, click the
IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your
printer, then click Search to locate your printer. If you do not know the IP address of the printer, see
Finding the IP Address of Your Printer on page 29.

1. Download the appropriate package for your operating system.
The available files are:
—  XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family.
—  XeroxOSDPkg-HPUXiab4-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations.
—  XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems.
—  XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems.
—  Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux environments.
—  Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux environments.
—  Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux environments.
—  Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux environments.

2. Toinstall the Xerox® Print Driver package, open the package with your OS package manager or use
the appropriate command-line utility for your OS.

—  AIX: rpm -U XeroxOSDPkg-AIXpowerpc-X.XX.XXX.XXXX.rpm

—  HPUX: swinstall -s XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz \*

—  Solaris (x86 based): pkgadd -d XeroxOSDPkg-Sun0Si386-x.xx.xxx.xxxx.pkg

—  Solaris (SPARC based): pkgadd -d XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg
—  Linux (RPM based 32-bit): rpm -U Xeroxv5Pkg-Linuxi686-x.xX.XXX.XXXX.rpm

—  Linux (Debian based 32-bit): dpkg -i Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb

—  Linux (RPM based 64-bit): rpm -U Xeroxv5Pkg-Linuxx86_64-Xx.XX.XXX.XXXX.rpm

—  Linux (Debian based 64-bit): dpkg -i Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb
The package installs files into /opt/Xerox/prtsys.

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press
Enteror Return.
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Other Drivers

The following drivers are available for download at www.xerox.com/office/WC6655drivers.

The Xerox® Global Print Driver works with any printer on your network, including those printers
made by other manufacturers. It configures itself for your individual printer upon installation.

The Xerox® Mobile Express Driver works with any printer available to your computer that supports
standard PostScript. It configures itself for the printer you select every time you print. If you travel
frequently to the same sites, you can save your favorite printers in that location and the driver saves
your settings.
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Paper and Media

This chapter includes:

Supported Paper.................
Loading Paper ....................

Printing on Special Paper
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Supported Paper

This section includes:

®  RECOMMENAEA MEAIA ...ttt sss s s ss st s s s s s s s s sasesenens 52
®  OFAEIING PUPET .ottt ass s s sss st ssss b s s s s e s s b e s s bbb s st st bas b s s b s s b s s enbenes 52
o General Paper LOAAING GUIAEIINES ...t sesessesssesstssssss s ssssssssssssssssssssssssssssssssssssssssnssssssssssssssnses 52
o Paper That Can DAmMAQGE YOUT PrHNETET ...ttt sssssssss s sssssssssssssssessssssssssssssssssssssssssssssssssees 53
®  PAPEr STOTAGE GUIAEINES. ...ttt s s s s s s s s bass s ssss s bsss s ses s ss s bass b sasseessasssnsen 53
o Supported Paper TYPeS ANA WEIGNTS ... sssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssnses 54
o SUpPOrted STANAAIA PAPEE SIZES ...t sssesssesssssssssssssssssessssasssssssssssssasssssssssssssssnees 54
e  Supported Paper Types and Weights for Automatic 2-Sided Printing ......ccceeveerveervnrcnsnnrensesssnssesennnes 55
®  SUPPOrted CUSLOM PUPET SIZES ..ot ississsies s sessssssissssss s sassssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnses 55

Your printer is designed to use various paper and other media types. To ensure the best print quality and
to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:
e www.xerox.com/paperRecommended Media List (United States)
e www.xerox.com/europaperRecommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6655supplies.

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
e  Adjust the paper guides to fit the paper size.

e  Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.
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Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

e Rough or porous paper

o Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e  Paper that has been folded or wrinkled
e  Paper with cutouts or perforations

e Stapled paper

e  Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Transparencies

& CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

e  Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

e  Reduce the exposure of paper to strong lights for long periods of time.

e  Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect
moisture.

e  Store paper flat, either on pallets, cartons, shelves, or in cabinets.
e Avoid food or drinks in the area where paper is stored or handled.

¢ Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or
gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.
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Supported Paper Types and Weights

Tray Paper Types Weights

All Trays Recycled 60-105 g/m?
Custom
Plain 75-105 g/m?
Hole Punched
Pre-Printed
Bond
Letterhead
Lightweight Cardstock 106-163 g/m?
Lightweight Glossy Cardstock

Cardstock 164-220 g/m?
Glossy Cardstock

Bypass Tray Labels
Envelope

Supported Standard Paper Sizes

European Standard Sizes North American Standard Sizes

All Trays A4(210 x 297 mm, 8.3 x 11.7 in) Legal (216 x 356 mm, 8.5 x 14in.)
B5(176 x 250 mm, 6.9 x 9.8 in.) Folio (216 x 330 mm, 8.5x 13 in.)
A5 (148 x 210mm,5.8 x 8.3 in.) Letter (216 x 279 mm, 85 x 11in.)
JISB5(182 x 257 mm,7.2 x 10.1 in.) Executive (184 x 267 mm,7.25 x 10.5in.)
215x315mm, 8.5x12.4in. 203 x254mm, 8 x10in.

Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.) Statement (140 x 216 mm, 55 x 8.5in.)
B6(125 x 176 mm, 49 x 6.9 in.) Monarch envelope (98 x 190 mm,
C5 envelope (162 x 229 mm, 39 x 7.5 in)
6.4 x 9 in) No. 9 envelope (99 x 226 mm, 3.9 x 8.9 in.)
C6 envelope (114 x 162 mm, No. 10 envelope (241 x 105 mm,
45 x 6.38 in.) 41 x 9.5 in)
DL envelope (110 x 220 mm, Envelope 6 x 9 (152 x 228 mm,6x9 in.)
4.33 x 8.66 in.) 76 x127 mm,3 x5 in.
JISB6(128 x 182mm, 5.0 x 7.2 in)) Postcard (89 x 140 mm, 3.5x 5.5 in.)
127 x178 mm, 5x 7 in. Postcard (102 x 152 mm, 4x 6 in.)
Postcard (100 x 148 mm, 3.9 x 5.8 in.)
Postcard (148 x 200 mm, 5.8 x 7.9 in.)
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Supported Paper Types and Weights for Automatic 2-Sided Printing

Paper Types Weights

Recycled 60-105 g/m?
Custom

Plain 75-105 g/m?
Hole Punched
Pre-Printed
Letterhead
Bond

Lightweight Cardstock 106-163 g/m?
Lightweight Glossy Cardstock

Supported Custom Paper Sizes

Trays 1 and 2
e  Width: 148.0-215.9 mm (5.8-8.5in.)
e Length: 210-355.6 mm (8.3-14in.)

Bypass Tray
e  Width: 76.2-215.9 mm (3-8.5in.)
e Length: 127-355.6 mm (5-14in.)

Automatic 2-sided Printing
e  Width: 148.0-215.9 mm (5.8-8.5in.)
e Length: 210-355.6 mm (8.3-14in.)

Duplex Automatic Document Feeder
e  Width: 148.0-215.9 mm (5.8-8.5in.)
e Length: 210-355.6 mm (8.3-14in.)
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Loading Paper

This section includes:
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Loading Paper in the Bypass Tray
1. Open the bypass tray.

2. If the bypass tray is loaded with paper already, remove any paper that is a different size or type.
3. Move the width guides to the edges of the tray.
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to
use it.

5. Load the paper in the tray.
6. Load hole punched paper with the holes to the right.

7. For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face down
with the top edge going into the printer.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to
jam.
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8. Adjust the width guides until they touch the edges of the paper.

9. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen.

Configuring Trays 1 or 2 for the Paper Length

You can adjust the lengths of trays 1 and 2 to accommodate A4/Letter and Legal paper sizes. In the
Legal length settings, the trays protrude from the front of the printer.

To change the 550-sheet feeders in trays 1 and 2 to match the paper length:
1. Remove all paper from the tray.

2. Toremove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly,
then pull it out.

3. To extend the tray, with one hand, hold the back of the tray. With the other hand, at the front of
the tray, press the release latch and pull the ends outward until they latch.
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4. To compress the tray for shorter paper, with one hand, hold the back of the tray. With the other
hand, at the front of the tray, press the release latch, then push the ends inward until they latch.

5. Load paper into the tray, then insert it back into the printer. For details, see Loading Paper in Trays
1-2 on page 59.

Loading Paper in Trays 1-2

1. Toremove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly,
then pull it out.
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2. Atthe back of the paper tray, press the paper lift tray down until it locks.
3. Adjust the paper length and width guides as illustrated.

4.  Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

5. Load paper into the tray.
—  Load hole punched paper with the holes to the right.
—  For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face
down with the top edge going into the printer.
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to
jam.
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6. Adjust the length and width guides to fit the paper.

7. Slide the tray back into the printer.

8. Push the tray in all the way.
Notes:
e If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is
locked down.

e If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.

9. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen.
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Printing on Special Paper

This section includes:

O ENVLOPES .ottt s R ARt st 62
0 LODIS et R AR e 65
O GLOSSY CONASTOCK w.ouvrverrerrrrrrerieesissiest s sisssessssssass s asssssssssssss s ssssssssssssssssassssssssssss s s ssssssssssssbasssssssssssenssssssssnssnsssnees 66

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6655supplies.

See also:
www.xerox.com/paperRecommended Media List (United States)
www.xerox.com/europaperRecommended Media List (Europe)

Envelopes

You can print envelopes from the bypass tray only.

Guidelines for Printing Envelopes

e  Print quality depends on the quality and construction of the envelopes. Try another envelope brand
if you do not get desired results.

e  Maintain constant temperatures and relative humidity.

e Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

e  Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of them.

e Inthe print driver software, select Envelope as the paper type.

e Do not use padded envelopes. Use envelopes that lie flat on a surface.

¢ Do not use envelopes with heat activated glue.

e Do not use envelopes with press and seal flaps.

e Use only paper envelopes.

e Do not use envelopes with windows or metal clasps.
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Loading Envelopes in the Bypass Tray
1. Open the bypass tray.

2.  Move the width guides to the edges of the tray.

Note: If you do not load envelopes in the bypass tray right after they have been removed from the
packaging, they can bulge. Flatten them to avoid jams.
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3. Toload envelopes, select an option:

— Toload envelopes with long edge flaps, place the envelopes with the short edge going into the
printer, flaps down and to the right.

— Toload envelopes with non-adhesive short edge flaps, place print side up, flaps open and
down, with the bottom edge entering the printer.
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e  For envelopes with adhesive short edge flaps, load the envelopes with the print side up,
flaps closed and down, and flaps going into the printer.

Note: To have envelopes print correctly, when you load envelopes with the flaps open, in the print
driver, select Portrait,Landscape, or Rotated Landscape, as needed. To flip the image, in the print
driver, use Rotate Image 180 Degrees, as needed.

If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen.

Labels

You can print labels from the bypass tray only.

Guidelines for Printing Labels

A

Use labels designed for laser printing.

Do not use vinyl labels.

Do not feed a sheet of labels through the printer more than once.

Do not use dry gum labels.

Print only on one side of the sheet of labels. Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

In the print driver software, select Label as the paper type.
Before loading labels, remove all other paper from the tray.

CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.
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Loading Labels in the Bypass Tray

1
2
3
4
5.
6.
7
8
9.
]

Remove all paper from the tray.

Load labels in the bypass tray, face up, with the top edge of the page feeding into the printer only.
Adjust the width guides until they touch the edges of the paper.

At the control panel, for Paper Settings, touch Size.

Scroll through the list, then touch Custom.

Specify the width and length, then touch OK.

Touch Type, then touch Labels.

Touch Confirm.

At your computer, in the Printing Preferences of the print driver, click the Printing Options tab.

0. For Paper Type, select Labels.

Glossy Cardstock

You can print Lightweight Glossy Cardstock and Glossy Cardstock up to 220 g/m? from any tray.

Guidelines for Printing on Glossy Cardstock

66

Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.

Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until
ready to use.

Remove all other paper from the tray before loading glossy cardstock.

Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in
the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal.
Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to
curl and jam in the printer.

In the print driver software, select the desired glossy cardstock type or select the tray loaded with
the desired paper.
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This chapter includes:
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Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected to an
active network. Make sure that you have the correct print driver software installed on your computer. For
details, see Installing the Software on page 44.

1. Select the appropriate paper.

2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.

3. Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.

4. Select your printer.

5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox®
Features for Macintosh. The title of the button can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.

7. Click Print to send the job to the printer.

See also:

Loading Paper on page 56

Selecting Printing Options on page 69

Printing on Both Sides of the Paper on page 76

Printing on Special Paper on page 62

68
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Selecting Printing Options

This section includes:

©  PLINE DIIVEN HEIP oottt se et s st s s ssse bbb s a s asas s sasesaees 69
®  WINAOWS PriNtING OPLIONS ..ottt sesssasstssssss s sessssssssssssssssssssssssssssssssssssssessssssssssssssssnsssssssssssessassssnses 70
o MacintoSh PriNtingG OPLIONS ...ttt sessssss s sss s sssssssssss s s ssssssssssssssssssssssssssssssssssssssssasssnsses 71
®  LiNUX PriNtING OPLIONS ...ttt esssss st sss s sssssss e s sssssssssssssssssessssssssassssssssssssssssssnees 72

Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences
become the default setting. Printing options that are set from within the software application are
temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.

— |

? B — (@ @
* el o |

Information about Printing Preferences appears in the Help window on two tabs:

e Contents provides a list of the tabs at the top and the areas at the bottom of the Printing
Preferences window. Use the Contents tab to find explanations for each of the fields and areas in
Printing Preferences.

e Search provides a field where you can enter the topic or function for which you need information.
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Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so that
you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

To select default printing options:
1. Navigate to the list of printers on your computer:
—  For Windows Vistaq, click Start>Control Panel>Hardware and Sound>Printers.
—  For Windows Server 2003 and later, click Start>Settings>Printers.
—  For Windows 7, click Start>Devices and Printers.
—  For Windows 8, click Control Panel>Devices and Printers.
Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then
select Personalize>Control Panel Home>Devices and Printers.
2. Inthe list, right-click the icon for your printer and click Printing Preferences.
3. Inthe Printing Preferences window, click a tab, select the options, then click OK to save.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer. For example, if you want the highest print quality when you print a
document, in Printing Preferences, select High Resolution, then submit the print job.

1. With the document open in your software application, access the print settings. For most software
applications, click File>Print or press CTRL+P.

2. To open the Properties window, select your printer, then click the Properties or Preferences button.
The title of the button varies depending on your application.

3. Click a tab in the Properties window, then make selections.
4. To save your selections and close the Properties window, click OK.
5. Tosend the job to the printer, click OK.
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Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1.
2.

With the document open in your application, click File>Print.

Select the printer, then click Properties. Click the tabs in the Properties window, then select the
desired settings.

To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the
window, then click Save As.

Type a name for the set of printing options, then to save the set of options in the Saved Settings list,
click OK.

To print using these options, select the name from the list.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.

1.

vt wN

With the document open in your application, click File>Print.
Select your printer.

Select Xerox® Features from the Copies & Pages menu.
Select the desired printing options from the drop-down lists.
Click Print to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

o b whN~

With the document open in your application, click File>Print.

Select your printer from the Printers list.

Select the desired printing options from the drop-down lists in the Print dialog box.

Click Presets>Save As.

Type a name for the printing options, then click OK to save the set of options in the Presets list.
To print using these options, select the name from the Presets list.
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Linux Printing Options

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press
Enter or Return.

Printing from a Linux Workstation

To print from a Linux workstation:

1.
2.

o v bw

Create a print queue.

With the desired document or graphic open in your application, open the Print dialog box. For most
software applications, click File>Print or press CTRL+P.

Select the target print queue.

Close the Print dialog box

In the Xerox® GUI print driver, select the available printer features.
Click Print.

The Xerox® print driver accepts job ticket settings files that select additional settings or features.
You can also submit print requests through the command line using lp/lpr.

To create a job ticket using the Xerox® GUI print driver:

1.
2.
3.

Open the Xerox® GUI print driver.
Select the desired options.
Click Save As, then store the job ticket in a public location, such as /tmp.

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job
ticket. You can specify the information on the command line.

To create a job ticket using the command line:

1.
2.
3.

On the command line, as the root user, type xeroxprtmgr.
Select the desired options.
Click Save As, then store the job ticket in a public location, such as /tmp.

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job
ticket. You can specify the information on the command line.

The following commands are examples of how to print using a job ticket:

72

lp -d{Target_Queue} -0JT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File}
lp -dMyQueue -0JT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile
lp -dMyQueue -0JT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile
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Managing Jobs

This section includes:

e Managing Jobs at the CONTIOL PANEL ...ttt sssssssssssss s ssssssssassssnees 73
o  Managing Secure aNd Held PrHNT JODS ...ttt ssssssssssss s sssssssssssssssesssasssssssssssnses 74
e Managing Jobs in CentreWare INTEIrNETL SEIVICES ...t sessssssssssssssssssssessssssssssssssanees 75

Managing Jobs at the Control Panel

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You
can pause, delete, print, or view job progress or job details for a selected job. For details, see Printing
Special Job Types on page 85.

To pause printing:
1. Atthe control panel, press the Interrupt button. The printer continues to print while it determines
the best place to pause the spooled print job.

2. Toresume printing, press the Interrupt button again.

To pause the print job with the option to delete it:
1. At the control panel, press the Stop button.
2. Do one of the following:
—  Todelete the print job, touch Cancel Printing.
—  Toresume the print job, touch Resume Printing.

Note: If you do not make a selection within 60 seconds, the job automatically resumes.

To view active, secure, or completed jobs:
1. Atthe control panel, press the Job Status button.
2. Tosee allist of specific job types, touch a tab.
— Toview jobs that are processing or waiting to process, touch the Active Jobs tab.

—  Toview Secure Print jobs, touch the Secure Print Jobs, or My Secure Jobs tab. Touch the
folder, enter the passcode number using the keypad, then touch OK.

—  Toview completed jobs, touch the Completed Jobs tab.
3. Torefine the list, touch the Down arrow.
4. To see details about a job, touch the job.
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To delete a job:
1. At the control panel, press the Job Status button.
2. From any of the job type tabs, touch the job.
3. Touch Delete.
Notes:
e The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.
e  Only the user that sent the job or the system administrator can delete a secure print job.

From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs
stored in printer folders. You can select and print jobs from any of the lists. To print the job, see Printing
Special Job Types on page 85.

To view saved jobs:

1. At the printer control panel, press the Services button.
2. Touch Print From, then touch Saved Jobs.

3. Toview the saved jobs, touch a folder.

4. To see details about a job, touch the job.

Managing Secure and Held Print Jobs

When you send a secure print job, the job is held until you release it by typing a passcode at the control
panel.

To view a list of secure print jobs:

1. At the printer control panel, press the Job Status button.

2. Touch Secure Print Jobs or My Secure Jobs. For details, see Secure Print on page 85.

3. Note: Only the user that sent the job or the system administrator can delete a secure print job.

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held
until you release it. For details, see Releasing Held Print Jobs on page 90.

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window
using LPR, Port 9100, or from the Jobs tab in CentreWare Internet Services.

To view a list of the unidentified jobs and release them:

1. Touch the Unidentified Print Jobs tab.

2. Do one of the following:
— Torelease a held job, touch the job, then touch Release.
— Torelease all held jobs, touch Release All Jobs.

A print job can be held by the printer when it is unable to complete a print job. For example, it needs
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing.
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Managing Jobs in CentreWare Internet Services

You can view a list of active jobs and delete print jobs from the Active Jobs list in CentreWare Internet
Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in CentreWare

Internet Services.
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Printing Features

This section includes:
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Printing on Both Sides of the Paper

Paper Types for Automatic 2-Sided Printing

The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided
document, verify that the paper type and weight are supported. For details, see Supported Paper Types
and Weights for Automatic 2-Sided Printing on page 55.

Printing a 2-Sided Document

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings
for portrait or landscape orientation from the application for printing the document.
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2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

Y N
—
A » - >

Portrait Portrait Landscape Landscape
2-Sided Print 2-Sided Print, Flip on Short | 2-Sided Print 2-Sided Print, Flip on Short
Edge Edge

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a specific
tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet
When printing a multiple-page document, you can print more than one page on a single sheet of paper.

Print 1, 2, 4, 6,9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout
is on the Document Options tab.
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Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and
prints four page images per sheet of paper, two page images on each side. The pages are printed in the
correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter

and creep.

e  Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72 in.).

e Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

|20 1
/

Print Quality

Print-quality modes:

e Standard print-quality mode: 600 x 600 dpi

e High-Resolution print-quality mode: 2400 x 600 dpi

e  Toner Saver print-quality mode
—  This mode reduces the amount of toner used for print jobs.
—  You can use this feature for draft quality output.

Using Image Options

The Image Options control the way the printer uses color to produce your document. The Windows
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each
system has standard modes of color control for normal use and custom color options for the more
advanced users. Image Options are on the Image Options tab of the Properties window. There, they are
divided into Color Correction, Color By Words, and Color Adjustments tabs. For details on accessing the
Properties window, see Printing Overview on page 68.
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The Color Correction tab provides standard color modes:
e  Xerox Black and White: Converts all color in the document to black and white or shades of gray.

e Xerox Automatic Color: Applies the best color correction to text, graphics, and images. Xerox
recommends this setting.

e  Color Correction: Provides a selection of commercial press, spot color, CIE, and gray image
simulations to match your document color. This tab also provides a Custom Automatic Color option
for advanced color corrections based on RGB Color, CMYK Color, Spot Color, CIE Color, or Gray.

The two remaining tabs provide additional ways of adjusting the colors for more specific color
requirements.

The Color By Words tab provides a three-step process for defining custom color correction. By making a
selection from each of the three fields, you create a sentence for controlling the color characteristics of
the document. You can create several sentences to more precisely control the color content of the
document. As you create a Color By Words sentence, it appears in the window below the selection fields.
The sentence structure is made of three parts:

e  What Color to Change?: Provides a list to select a color or range of colors to adjust, such as All
Foliage-Green Colors.

e  How Much Change?: Lets you select how much effect to make to the selected color.
e  What Type of Change?: Lets you select the type of change, such as Vivid, from a list.

The Color Adjustments tab provides a set of six sliders for adjusting the individual components of the
selected colors. You can use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and
yellow components of the color.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the first
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

e No Covers does not print cover pages. No cover pages are added to the document.

e  Front Only prints the first page on paper from the specified tray.

e  Back Only prints the back page on paper from the specified tray.

e  Front and Back: Same prints the front and back cover pages from the same tray.

e  Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side
two, or both sides of the cover pages.
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Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

e Insert Options provides the options to place an insert After Page X, where X is the specified page, or
Before Page 1.

e Insert Quantity specifies the number of pages to insert at each location.

e Pages specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down
arrow to the right of the Paper field to select a different paper size, color, or type.

e Job Setting displays the attributes of the paper for the remainder of the job.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to print
as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to
print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Pages specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down
arrow to the right of the Paper field to select a different paper size, color, or type.

e 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:
— 1-Sided Print prints the exception pages on one side only.

—  2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

—  2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

—  Use Job Setting prints the job using the attributes shown in the Job Settings box.
e Job Setting displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.
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Scaling

You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 %. In
Windows, you can find the Scale Options in the print driver on the Printing Options tab.

50% 100% 200%

XEROX

XEROX

XEROX

1. To access Scaling Options, to the right of the Paper field, click the arrow, then select Other
Size>Advanced Paper Size.

2. Select an option.
—  No Scaling: You can use this option to retain the original image size.

—  Automatically Scale: You can use this option to change the print from one standard paper size
to another. The Original Document Size is scaled to fit on the selected output paper size shown
in the Output Paper Size field.

—  Manually Scale: You can use this option to change the output print size by a specified
percentage.
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Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before
distribution.

Notes:
e Not all options listed are supported on all printers. Some options apply only to a specific printer
model, configuration, operating system, or driver type.

e  Watermarks are not supported for some print drivers when booklet is selected or when more
than one page is printed on a sheet of paper.

Using the watermark options, you can do the following:
e Create a watermark or edit an existing watermark using the Watermark Editor:

—  AText Watermark uses the characters typed in the Text field as the watermark. You can create
a text watermark to print on a document. Select options such as font size, font type, font color,
and angle.

— A Picture Watermark uses an image as the watermark. The picture file can be in .bmp, .gif, or
jpg format. You can create a picture watermark to print on a document, and select options
including size and position on the page.

—  ATime Stamp Watermark uses a time stamp as the watermark. You can create a time stamp
watermark to print on a document. Time stamp elements include the day, date, time, and time
zone.

e  Place a watermark on the first page or on every page in a document.
e  Print a watermark in the foreground or background or blend it with the print job.

To print a Watermark:
1. Click Document Options>Watermark.
2. From the Watermark menu, select the watermark.
3. Click Layering, then select how to print the watermark:
—  Print in Background prints the watermark behind the text and graphics in the document.

—  Blend combines the watermark with the text and graphics in the document. A blended
watermark is translucent, so you can see both the watermark and the document content.

—  Print in Foreground prints the watermark over the text and graphics in the document.
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Click Pages, then select the pages on which to print the watermark:

—  Print on All Pages prints the watermark on all pages of your document.

—  Print on Page 1 Only prints the watermark only on the first page of the document.
Click OK.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

Creating and Saving Custom Sizes

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications. For paper sizes that are supported for
each tray, see Supported Custom Paper Sizes on page 52.

To create and save custom sizes for Windows:

1.
2.
3.
4

5.

In the print driver, click the Printing Options tab.
For Paper, click the arrow, then select Other Size>Advanced Paper Size>Output Paper Size>New.
In the New Custom Paper Size window, enter the height and width of the new size.

To specify the units of measurement, at the bottom of the window, click the Measurements button,
then select Inches or Millimeters.

To save, in the Name field, type a title for the new size, then click OK.

To create and save custom sizes for Macintosh:

o b wnN-~

In the application, click File>Page Setup.

Click Paper Sizes, then select Manage Custom Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).

At the top of the window, double-click My Custom Size, then type a name for the new custom size.
Enter the height and width of the new custom size.

Click Print Margins, then select the printer from the list. Or set the top, bottom, right, and left
margins.

To save the settings, click OK.
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Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is available on a computer printing to a network printer.

To be notified when your print job completes:

1. Inthe print driver, click the Printing Options tab.

2. Click Notification>Notify for Completed Jobs>Enabled.
3. Click OK.
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Printing Special Job Types

This section includes:
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Special job types allow you to send a print job from your computer, then print it from the printer control
panel.

Select special job types in the print driver from the Printing Options tab.

Secure Print

Secure print allows you to associate a 4—10 digit passcode with a print job when sending it to the printer.
The job is held at the printer until you enter the passcode at the control panel.

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If
you must use a different passcode, you can override it in the application print driver.

Sending a Secure Print Job

1. On the Printing Options tab, from the Job Type list, select Secure Print.
2. Type a 4-10 digit passcode for the Secure Print job.
3. Inthe Confirm Passcode field, type the passcode again.

Notes:

e If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode
Required window. You can use the passcode supplied by the printer, or you can type your own
passcode to use in the Secure Print window.

e The passcode is associated with your user name. After you set a passcode, it becomes the
default passcode for any print job that requires a passcode on all Xerox® printers. You can reset
the passcode at any time from any window that contains the passcode.

Click OK.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.

e NOWmE
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Releasing a Secure Print

1.

nwnLtwheN

At the control panel, press the Job Status button.

Touch the Secure Print Jobs or My Secure Jobs tab.

Touch the folder that holds the print job.

Using the keypad, enter the passcode that you assigned to the print job, then touch OK.
Touch the corresponding print job in the list, then touch Release.

Deleting a Secure Print

1. Atthe control panel, press the Job Status button.

2. Touch the Secure Print Jobs or My Secure Jobs tab.

3. Touch the folder that holds the print job.

4. Enter the passcode number that you assigned to the print job using the keypad.
5. Touch the corresponding print job in the list, then touch Delete.

Sample Set

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the
remaining copies at the printer. After you review the sample copy, you can select the job name from the
printer control panel to print the additional copies.

Sending a Sample Set Print Job

ok wh~
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On the Printing Options tab, from the Job Type list, select Sample Set.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.

A sample copy prints immediately. The sample copy is not counted as part of the print job.
After reviewing the copy, use the printer control panel to print or delete the remaining copies.

Note: You can use Sample Set as a part of the Earth Smart settings. In Earth Smart settings, set
Sample Set as your default Job Type.

To print the job, select it from the job list on the printer control panel.
Press OK.
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Releasing the Remaining Prints After Printing a Sample Set

1. At the control panel, touch Job Status.
2. Touch the corresponding print job in the list.

Note: The control panel displays Held: Sample Set next to the job name.

3. Touch Release.
The remainder of the job prints, and the job is deleted from the printer hard drive.

Delay Print

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at
which you would like the job to print. If the time you enter is earlier than the time that you submit the
print job, it prints on the following day. The Delayed Print default time is midnight.

Sending a Delay Print Job

1. On the Printing Options tab, from the Job Type list, select Delay Print.

2. Inthe Delay Print window, select the Tab key to move from the hour section to the minutes section.
To select the time to send the print job, click the arrow buttons.

—  For a12-hour time format, type the hour (1-12), minutes (00-59), then select A.M. or P.M. To
toggle between A.M. and P.M,, click A.M. or P.M,, then use the Up arrow or Down arrow
buttons.

—  For a 24-hour time format, type the hour (1-23) and the minutes (00-59).
Note: The regional settings on your computer determine the time format.

3. Click OK.
4. Select other desired printing options and click OK.
5. Click OK or Print.

Note: To print the job after you send it but before the scheduled time, release the job at the printer
control panel.
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Saved Job

Saved Job or Store File in Folder stores a public or private job in the printer and prints the job as
requested at the printer control panel. This option is useful for documents that you print frequently. You
can assign a passcode to a private job to prevent unauthorized printing.

To print saved jobs, see Printing from Saved Jobs on page 91.

Sending a Public Saved Job

1.
2.
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12.
13.
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On the Printing Options tab, from the Job Type list, select Saved Job.

In the Saved Job window, for Job Name, do one of the following:

—  Type a name for the job.

—  Click the arrow to the right of the field and select a name from the list.

—  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted
automatically from the list. To remove names from the list other than the selected name, select
Clear List.

In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the
following:

—  Type the name of the destination folder.

—  Click the arrow to the right of the field, then select a folder name from the list.

—  Click the arrow to the right of the field, then select Default Public Folder.

To print the job now and also save the job, select the Print and Save check box.

Select Public.

Click OK.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.

A sample copy prints immediately. The sample copy is not counted as part of the print job.
To print the job, select it from the job list on the printer control panel.
Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on page
91.
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Sending a Private Saved Job

1.
2.

10.
11.
12.
13.
14.

On the Printing Options tab, from the Job Type list, select Saved Job.

In the Saved Job window, for Job Name, do one of the following:

—  Type a name for the job.

—  Click the arrow to the right of the field and select a name from the list.

—  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted
automatically from the list. To remove names from the list other than the selected name, select
Clear List.

In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the
following:

—  Type the name of the destination folder.

—  Click the arrow to the right of the field, then select a folder name from the list.

—  Click the arrow to the right of the field, then select Default Public Folder.

To print the job now and also save the job, select the Print and Save check box.

To store your job at the printer, select Private.

In the Passcode field, type a passcode. The passcode is associated with your user name. After you
set a passcode, it becomes the default passcode for any print job that requires a passcode on all
Xerox® printers. You can reset the passcode at any time from any window that contains the
passcode.

In the Confirm Passcode field, type the passcode again.

Click OK.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
Select an option for 2-sided printing.

Select a print-quality mode.

Select another tab or click OK.

To print the job, select it from the job list on the printer control panel.

Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on page
91.
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Held Print Jobs

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds.
If you send a sample job, the first copy of the job prints and the rest of the copies hold until you release
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is
held until you release it.

Releasing Held Print Jobs

At the control panel, press the Job Status button.

Touch Active Jobs.

To determine why a job was held, touch the job, then touch Details.
Do one of the following:

o

— Torelease a held job, touch the job, then touch Release.
— Torelease all held jobs, touch Release All Jobs.
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Print From

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB
Flash drive.

Printing from a USB Flash Drive

You can print .pdf, .tiff, and .xps files directly from a USB Flash drive.
Notes:
e If USB ports are disabled, you cannot use a USB card reader for authentication, update the
software, or print from a USB Flash drive.

e The system administrator must set up this feature before you can use it. For details, see the
System Administrator Guide at www .xerox.com/office/WC6655docs.

To print from a USB Flash drive:
1. Insert your USB Flash drive in a USB port on the printer. The Print from USB window appears.
The list at the bottom of the window displays the folders and printable files on the USB Flash drive.
2. To scroll through the list and locate the printable file, next to the list, use the arrows.
If the print file is in a folder, to open the folder, touch the name.
3. Touch the name of the printable file.
4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and
finishing options.
5. Press the green Start button.
6. To go back to the last screen, touch Back.
7. Tolook for other folders and printable files, touch Browse.

Printing from Saved Jobs

To print from saved jobs:

1. At the control panel, press the Services button, then touch Print From.

2. Select Saved Jobs, then touch the name of the folder containing the saved job.

3. Touch the name of the saved job that you want to print.
Note: To print a private saved job, touch the name of the job, then enter the passcode.

4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and
finishing options.

5. Press the green Start button.

6. After the job prints, to return to the list of saved jobs, touch Browse.
To return to the list of folders, touch Back.
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Printing from Mailbox
Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.

To print from a mailbox:

1. At the control panel, press the Services button, then touch Print From.

2. Select Mailbox, then touch the name of the folder containing the document.
Note: If Mailbox is not displayed, use CentreWare Internet Services to enable the Scan to Mailbox
and Print From Mailbox features. Then create a scan to mailbox folder. For details, see the System
Administrator Guide atwww.xerox.com/office/WC6655docs.

3. Touch the name of the document that you want to print.

4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and
finishing options.

5. Press the green Start button.
After the job prints, to return to the list of documents in the mailbox, touch Browse.
To return to the list of folders, touch Back.
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Printing from CentreWare Internet Services

You can print .pdf, .ps, .pcl, and .xps files directly from CentreWare Internet Services without having to
open another application or the print driver. The files can be stored on a local computer hard drive, mass
storage device, or network drive.

To print from CentreWare Internet Services:

1.

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer
on page 29.
In CentreWare Internet Services, click the Print tab.

To select the file from a local network or remote location, click Browse, select the file, then click
Open.

For Printing, select the desired options for the job.
—  Normal Print prints a job immediately.
—  Secure Print prints a job after you enter your passcode at the printer control panel.

—  Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining
copies at the printer.

—  Save Job for Reprint saves a print job in a folder on the print server for future printing. You can
specify a job name and folder.

—  Delay Print prints a job at a specified time up to 24 hours from the original job submission.
If Accounting is enabled, enter your User ID and account information.
Click Submit Job.

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation
message to appear before you close this page.
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Basic Copying

1. To clear previous settings, press the yellow Clear All button on the control panel.
2. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

3. Press the Services Home button, then touch Copy.

4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of
copies appears in the upper right corner of the touch screen.

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button,
then re-enter the number.

5. Change the copy settings as needed. For details, see Selecting Copy Settings on page 98.
6. Pressthe green Start button.

Notes:

e To pause or cancel a copy job, press the red Stop button on the control panel.
e Tointerrupt a copy job, press the Interrupt button on the control panel.

e  On the touch screen, touch Resume Scanning to continue the job, or Cancel Scanning to cancel
the job completely.

Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

e Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14 in.).
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Document Glass Guidelines
The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex
automatic document feeder.

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

e  Coated or carbonless paper or items other than paper such as cloth or metal
e Envelopes

e  Books

Document Feeder

e Insert originals face up, with page one on top.

e The confirmation indicator illuminates when
you load the originals correctly.

e Adjust the paper guides so they fit against the
originals.

e The document feeder supports paper weights
of 50-125 g/m?for 1-sided pages, and
60-125 g/m?for 2-sided pages.

e The document feeder supports paper sizes
from 139.7 x 139.7 mm (5.5x 5.5 in.)
through 215.9 x 355.6 mm (8.5x 14 in.).

e The maximum document feeder capacity is
approximately 60 sheets of 80 g/m? paper.

Duplex Automatic Document Feeder Guidelines

When loading originals into the duplex automatic document feeder, follow these guidelines:

e Insert originals face up with the top of the page entering the feeder first.

e  Only place loose sheets of paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the originals.

e  Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
e Do not load originals above the MAX fill line.
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Selecting Copy Settings

This section includes:
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Basic Settings
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Selecting Color or Black and White Copies

If the original document contains color, you can create copies in full color, a single color, or in black and
white.

To select the output color:

1.
2.

Press the Services Home button, then touch Copy.
For Output Color, select an option.

—  Color: This option copies in full color output using all four printing colors, cyan, magenta,
yellow, and black.

—  Black and White: This option copies in black and white only. Colors in the original document
are converted to shades of gray.

—  More: This option provides an additional choice.

e Single Color: This option copies in shades of a single color. In the color palette window,
select a color.

Touch OK.
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Reducing or Enlarging the Image
You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 % .

To reduce or enlarge the image:
1. Press the Services Home button, then touch Copy.
2. Touch an option;

—  Toreduce or enlarge the percentage incrementally, under Reduce/Enlarge, touch Plus (+) or
Minus (-).

—  Toreduce or enlarge the percentage using the alphanumeric keypad to type a specific value,
under Reduce/Enlarge, touch the current displayed value.

—  Toreduce or enlarge proportionally, touch Reduce/Enlarge, then touch Proportional %.
e Toreduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-).

e Toreduce or enlarge the percentage using the alphanumeric keypad, touch the current
displayed value.

e  Presets (X-Y%) allow you to select from a list of preset values. Touch More for additional
preset values.

e To center the image on the page, select the Auto Center check box.

—  Toreduce or enlarge the width and length of the image by different percentages, touch
Reduce/Enlarge, then touch Independent %.

e  Width:X% allows you to reduce or enlarge the width of the image incrementally using the
alphanumeric keypad or the Plus (+) and Minus (-) buttons.

e Length:Y% allows you to reduce or enlarge the length of the image incrementally using
the alphanumeric keypad or the Plus (+) and Minus (-) buttons.

e  Presets (Y/X) allow you to select from a list of preset values. Touch More for additional
preset values.

e To center the image on the page, select the Auto Center check box.
3. Touch OK.

Selecting the Paper Tray

To make copies on Letterhead, colored paper, or different paper sizes, you load the desired paper into
any tray, then select the tray as the source for your copy job.

To select the tray to use for copies:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the desired tray.
3. If the desired tray is not listed, select another tray:
a. Touch More for additional options.
b. Touch the desired tray.
4.  Touch OK.
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Selecting 2-Sided Copy Options
Use the document feeder or the document glass to copy one or both sides of a 2-sided original.

To select 2-sided copy options:
1. Press the Services Home button, then touch Copy.
2. Under 2-Sided Copying, select one of the following:
— 1->1 Sided scans only one side of the originals and produces 1-sided copies.

— 1->2 Sided scans only one side of the originals and produces 2-sided copies. To rotate the
second sides, touch Rotate Side 2.

—  2->2 Sided scans both sides of the originals and produces 2-sided copies. To rotate the second
sides, touch Rotate Side 2.

—  2->1 Sided scans both sides of the originals and produces 1-sided copies.
3. Press the green Start button.
—  The document feeder automatically copies both sides of the 2-sided original.

— A message appears on the control panel when it is time to place the next original on the
document glass.

Selecting Collated Copies

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a
six-page document, the copies are printed in this order:

1,2,3,4,56;1,2,3,4,5,6;1,2,3,4,5,6

To select collated copies:
1. Press the Services Home button, then touch Copy.
2. Under Copy Output, touch Collated if it is not already selected.

Selecting Uncollated Copies
Uncollated copies print in the following order:
1,1,1,2,2,2,3,3,3,4,4,4,5,5,5,6,6,6

To select uncollated copies:
1. Press the Services Home button, then touch Copy.
2. For Copy Output, touch Uncollated.
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Image-Quality Settings

This section includes:
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Specifying the Original Type

The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

To specify the original type:

1.  Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Original Type.

3.  On the Original Type screen, select the setting that matches your original document best.
4.  Touch OK.

Adjusting Brightness, Sharpness, and Saturation
You can lighten or darken copies and adjust the sharpness and saturation.

To adjust the image:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Image Options.

3. On the Image Options screen, adjust the sliders up or down as needed:
— Lighten/Darken lightens or darkens the image.
—  Sharpness sharpens or softens the image.
—  Saturation makes the image colors more vivid or pastel.

4. Touch OK.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To change this setting:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4.  Touch OK.

Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To increase or reduce the contrast of the copies:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Image Enhancement.
3. On the Image Enhancement screen, adjust the contrast:
—  Auto Contrast allows the printer to set the contrast automatically.

—  Manual Contrast allows you to adjust the contrast manually. To increase or decrease the
contrast, move the Manual Contrast slider up or down. The middle position on the slider,
Normal, does not change the contrast.

4. Touch OK.

Selecting Color Effects

If you have a color original, you can adjust the color of the copy using preset color effects. For example,
you can adjust colors to be brighter or cooler.

To select a preset color effect:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Color Presets.

Note: This feature is not available when Output Color is set to Black and White.

3. On the Color Presets screen, touch the desired preset color effect. The sample images show how the
colors are adjusted.

4. Touch OK.
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Adjusting the Color Balance

If you have a color original, you can adjust the balance of the printing colors between cyan, magenta,
yellow, and black before printing your copy.

To adjust the color balance:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Color Balance.

Note: This feature is not available when Output Color is set to Black and White.

3. To adjust the density levels of all four colors:
a. Onthe Color Balance screen, touch Basic Color.
b. Move the sliders to adjust the level for each color.
4. To adjust the highlight, midtone, and shadow density levels by color:
a. On the Color Balance screen, touch Advanced Color.
b. Touch the color you want to adjust.
¢. Move the sliders to adjust the levels for highlights, midtones, and shadows.
d. Repeat the previous two steps for additional colors.
5. Touch OK.
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Layout Settings

This section includes:
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Specifying the Orientation of the Original

If you plan to have the copies automatically stapled, specify the orientation of the original.

1.
2.
3.

Press the Services Home button, then touch Copy.

Touch the Layout Adjustment tab, then touch Original Orientation.

On the Original Orientation screen, touch the desired orientation:

—  Portrait Originals and Landscape Originals refer to the images on the originals.

— Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

Note: If you are using the document glass, the orientation of the original is as seen before turning it
over.

Touch OK.

Specifying the Size of the Original

To scan the correct area of the original, specify the original size.

1.
2.
3.

Press the Services Home button, then touch Copy.

Touch the Layout Adjustment tab, then touch Original Size.

On the Original Size screen, select an option:

—  Auto Detect: The printer detects the size of the original document.

—  Preset Scan Area: You can specify the area to scan when it matches a standard paper size. In
the scrolling list, touch the desired paper size.

—  Custom Scan Area: You can specify the height and width of the area to scan. To specify an
areaq, touch the Length (Y) and Width (X) arrows.

Touch OK.
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Selecting Book Copying

When copying a book, magazine, or other bound document, you can copy either the left or right page
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as
a single image on one sheet of paper.

Note: You must use the document glass to make copies from books, magazines, or other bound
documents. Do not place bound originals in the document feeder.

To set up book copying:
1.  Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Book Copying.
3. On the Book Copying screen, select an option:
—  Off copies both pages of an open book as one image on a single sheet of paper.

— Both Pages copies the left and the right pages of an open book onto two sheets of paper. If
Binding Edge Erase is required, touch the arrows to erase up to 50.8 mm (2 in.).

—  Left Page Only copies only the left page of an open book on a single sheet of paper. If Binding
Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.).

— Right Page Only to copy only the right page of an open book on a single sheet of paper. If
Binding Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.)

4. Touch OK.

Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than
the page size. Originals must be positioned as follows for image shift to work correctly:

e Document Feeder: Position originals face up, long edge entering the feeder first.

e Document Glass: Position originals face down, in the back-left corner of the document glass, long
edge to the left.

To change the placement of the image:
1. Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Image Shift.
3. Onthe Image Shift screen, select an option:
—  Auto Center centers the image on the page.

—  Margin Shift allows you to specify the position of the image. To specify the amount of shift for
Side 1, touch the Up/Down and Left/Right arrows. To specify the amount of shift for Side 2,
touch the Up/Down and Left/Right arrows, or select Mirror Side 1.

Note: You can use preset values that were previously saved by the system administrator. Touch
Presets in the lower left corner of the screen, and select a preset from the drop-down menu.

4. Touch OK.

106 Xerox® WorkCentre® 6655 Color Multifunction Printer
User Guide



Copying

Erasing the Edges of Copies

You can erase content from the edges of your copies by specifying the amount to erase on the right, left,
top, and bottom edges.

To erase edges on copies:

1. Press the Services Home button, then touch Copy.

2. Touch the Layout Adjustment tab, then touch Edge Erase.
3. Onthe Edge Erase screen, select an option:

— All Edges erases all four edges by the same amount. To specify the amount to erase from the
edge, touch the All Edges arrows.

— Individual Edges specifies different amounts for the edges. To specify the amount to erase
from each edge, touch Side 1, then touch the Left, Right, Top, and Bottom arrows. To specify
the amount to erase from each edge, touch Side 2, then touch the Left, Right, Top, and
Bottom arrows, or touch Mirror Side 1.

Note: You can use preset values that were previously saved by the system administrator. Touch
Presets in the lower left corner of the screen, and select a preset from the drop-down menu.

4. Touch OK.

Inverting the Image

You can invert your original, as a mirror image or as a negative image. You can use one or both of these
options.

To invert the image:
1. Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Invert Image.
3. Onthe Invert Image screen, select an option:
—  Mirror Image reflects each image left to right on the page.
— Negative Image reverses the black and white values.
4.  Touch OK.
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Output Format Settings

This section includes:
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Creating a Booklet

The booklet feature reduces the original page images to fit two images on each side of the printed page.
You can print copies in booklet format.

Note: In this mode, the printer scans all of the originals before printing the copies.

To create a booklet:
1. Press the Services Home button, then touch Copy.
2. Touch the Output Format tab, then touch Booklet Creation.
3. Onthe Booklet Creation screen, touch On.
4. To specify 2-sided originals:
a. Touch Original Input.
b. Touch 2-Sided Originals.
5. Toselect a paper tray:
a. Touch Paper Supply.
b. Touch the desired tray.
6. Touch OK.
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Including Covers

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight
paper. The printer selects the paper from a different tray. The covers can be blank or printed.

Note: The paper used for the covers must be the same size as the paper used for the rest of the
document.

To select the type of covers and the tray to use for the cover paper:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.
3. Touch the Output Format tab, then touch Special Pages.
Note: If Booklet Creation is turned off or the paper supply is set to Auto Select, Special Pages are
unavailable.
4. On the Special Pages screen, touch Covers.
5. Under Covers Options, select an option:
—  Front & Back Same includes front and back covers from the same tray.
—  Front & Back Different includes a front and a back cover from different trays.
From the drop-down menus that appear, select options for the front and back covers:
e Blank Cover inserts a blank cover.
e  Print on Side 1 prints on the front side of the cover.

e  Print on Side 2 prints on the back side of the cover. To rotate the image on side 2 by
180 degrees, touch Rotate Side 2.

e  Print on Both Sides prints on both sides of the cover. To rotate the image on Side 2 by
180 degrees, touch Rotate Side 2.

—  Front Only includes only a front cover.

—  Back Only includes only a back cover.
6. Under Paper Supply, touch the desired tray.
7.  Touch OK.
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Specifying Chapter Start Pagination

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side
of the paper.

To set the start side of particular pages:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, Chapter Starts is unavailable.

3. Touch the Output Format tab, then touch Special Pages>Chapter Starts.

4. On the Chapter Starts screen, touch the Page Number field, then use the alphanumeric keypad to
enter the page number.

5. Under Start Chapter, select an option:

— On Right Page specifies the front side of the paper.

—  On Left Page specifies the back side of the paper.

Touch Add. That page is added to the list on the right side of the screen.
Repeat the three previous steps to set other pages.

Touch Close. The page settings appear in the list on the right side of the screen.
Touch OK.

L e N
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Adding Inserts

You can insert blank pages or pre-printed sheets in specific locations in your copy job. You must specify
the tray containing the inserts.

Note: The paper used for the inserts must have the same width as the paper used for the rest of the
document. Inserts cannot be added if Booklet Creation is selected.

To add inserts:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, inserts cannot be added.

3. Touch the Output Format tab, then touch Special Pages>Inserts.

4. On the Inserts screen, touch the After Page Number field, then use the alphanumeric keypad to
enter the page number.

5. To specify the number of sheets to insert at that location, touch the Insert Quantity arrows.
6. To specify the paper tray to use for the insert:
a. Touch Paper Supply.
b. Touch the desired tray.
c¢. Touch OK.
7. Touch Add. The insert appears in the list on the right side of the screen.
8. Repeat the three previous steps to add additional inserts.
9. Touch Close. The inserts appear in the list on the right side of the screen.

Note: To edit or delete an insert, touch the insert in the list, then touch an action in the drop-down
menu.

10. Touch OK.

Specifying Exception Pages

You can print exception pages in a copy job using paper from a different tray. The paper used for the
exception pages must be the same size as the paper used for the rest of the document.

Note: You cannot add exception pages if the paper supply is set to Auto Select, or if Booklet
Creation is selected.

To specify the exception pages:
1. Press the Services Home button, then touch Copy.

Note: If the paper supply is set to Auto Select, exception pages are unavailable.

2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.
3. Touch the Output Format tab, then touch Special Pages>Exceptions.

4. On the Exceptions screen, touch the beginning Page Number field. Then use the alphanumeric
keypad to enter the starting value for the range of the exception pages.
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10.

Touch the ending Page Number field, then use the alphanumeric keypad to enter the ending value
for the range of exception pages.

Note: To specify a single page as an exception, enter its number as the start and end of the range.

To specify the paper used for the exception pages:

a. Touch Paper Supply.

b. Touch the tray containing paper for the exception pages.

c¢. Touch OK.

Touch Add. The exception pages are added to the list on the right side of the screen.
Repeat the four previous steps to add additional exception pages.

Touch Close. The exception pages appear in the list on the right side of the screen.

Note: To edit or delete an exception page, touch the page in the list, then touch the desired
operation in the drop-down menu.

Touch OK.

Adding Annotations

You can automatically add annotations such as page numbers and the date to your copies.

Notes:

e Annotations are not added to covers, tabs, inserts, or blank chapter start pages.
e Annotations cannot be added if Booklet Creation is selected.

To add annotations:

1.
2.
3.

112

Press the Services Home button, then touch Copy.

Touch the Output Format tab, then touch Annotations.
To insert page numbers:

a. Onthe Annotation screen, touch Page Numbers>On.
b. Touch Apply To, then select an option.

¢. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the page
number.

d. Touch an arrow to position the page number in the header or footer. The sample page shows
the location of the page number.

Touch OK.

f.  Tochange the text formatting, touch Format & Style, choose the desired settings, then touch
OK.

To insert a comment:

a. Touch Comment>On.

b. Touch Apply To, then select an option.
c. Touch an existing comment in the list.

Note: To create a comment, touch a blank row, use the touch screen keyboard to type the text, then
touch OK.
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Touch an arrow to position the selected comment in the header or footer. The sample page
shows the location of the comment.

Touch OK.

To change the text formatting, touch Format & Style, choose the desired settings, then touch
OK.

To insert the current date:

a.

b.
C.
d

m

Touch Date>On.
Touch Apply To, then select an option.
Under Format, select a format for the date.

Touch an arrow to position the date in the header or footer. The sample page shows the
location of the date.

Touch OK.

To change the text formatting, touch Format & Style, choose the desired settings, then touch
OK.

To insert a Bates Stamp:

a.
b.

C.
d.

Touch Bates Stamp>On.

Touch the Starting Page Number field, then use the alphanumeric keypad to enter the
starting page number. Leading zeros can be included.

Touch Apply To, then select an option.
Under Stored Prefixes, touch an existing prefix in the list.

Note: To create a prefix, touch a blank row, use the touch screen keyboard to type up to eight
characters, then touch OK.

e. Under Position, touch an arrow to position the Bates Stamp in the header or footer. The sample
page shows the location of the Bates Stamp.

f.  Touch OK.

g. Tochange the text formatting, touch Format & Style, choose the desired settings, then touch
OK.

Touch OK.
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Printing Multiple Pages Per Side

You can copy a single page and have it print multiple times onto one or both sides of the paper. The
printer reduces the pages proportionally to fit.

To print multiple original pages on a side:
1. Press the Services Home button, then touch Copy.
2. Touch the Output Format tab, then touch Page Layout>Pages per Side.
3.  Touch the number of original pages for each side of the paper. To specify a different number:
a. Touch Specify Rows & Columns.
b. Touch the Rows arrows to change the number of rows.
¢. Touch the Columns arrows to change the number of columns.
d. Select the Rotate check box to rotate the page.

Note: The right side of the screen contains a diagram of the image layout.

4.  Touch Original Orientation, then Portrait Originals or Landscape Originals.
5. Touch OK.

Repeating an Image

You can make multiple copies of an original image on one or both sides of the paper. This is useful for
duplicating a small image.

To repeat an image on a sheet of paper:
1. Press the Services Home button, then touch Copy.
2. Touch the Output Format tab, then touch Page Layout>Repeat Image.
3. Specify the number of images to print on the page:
—  Preset buttons repeat the image two, four, six, or nine times on each side of the paper.

—  Specify Rows & Columns allows you to determine the number of images. To enter the number
of rows and columns, touch the Rows or Columns field, then use the alphanumeric keypad or
touch the arrows. To rotate the paper, select the Rotate check box.

—  Auto Repeat allows the printer to determine the maximum number of images that can fit on
the currently selected paper size. Touch Original Orientation, and select Upright Images or
Sideways Images from the drop-down menu. The sample page shows the image layout.

4. Touch OK.
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Advanced Copying

This section includes:
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PriNTING 0 SAMPLE COPY .ot iseississessississssssssssssssssssssssessssssssssssssssssssssssssssssssssssssssasssssssssssssssesssssssssses 116
SAVING COPY SOILINGS ...ttt s s s sssssssssss s ssssssssssassssssssssessssssessssssessssssssssassssasssnes 116
Retrieving SAVEd COPY SEILINGS ...ttt sasssses s sassssssssssssssssssssssssssssssssssssssssssssssssssssanns 116

Building a Copy Job

Use this feature to produce complex copy jobs that include a variety of originals requiring different copy
settings. Each segment of the job can have different copy settings. Once all the segments are
programmed, scanned, and temporarily stored in the printer, the copy job prints.

To build a copy job with multiple segments:

1.
2.

Press the Services Home button, then touch Copy.

Program and scan the first segment:

Load the originals for the first segment.

Select the required settings, such as layout adjustments, image quality, and options.
Touch the Job Assembly tab, then touch Build Job>On.

Touch Options.

Select or clear the Display Summary window between segments check box.

Select or clear the Turn Build Job Off after Job is Submitted check box.

Touch OK.

Press the green Start button on the control panel.

T@e e a0 oo

Program and scan additional segments:

a. Load the originals for the next segment.

b. When the Build Job screen appears, touch Program Next Segment.

¢. Using the appropriate tabs, select the required settings.

d. Pressthe green Start button to scan the originals for that segment.

Repeat the previous step for each remaining segment.

Touch the Quantity for Final Job field, then use the alphanumeric keypad to enter the number of
copies.

On the Build Job screen, touch Submit Job.

To delete the job, touch Delete All Segments.
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Printing a Sample Copy

The Sample Copy feature prints a single copy of a job and holds the remaining copies. This feature
allows you to review and approve the job before you print the entire set.

Note: The sample copy is not counted as part of the quantity selected.

To print a sample copy of your job:

1. Press the Services Home button, then touch Copy.
Change the copy settings as needed.

Touch the Job Assembly tab, then touch Sample Job>On.
Touch OK.

Press the green Start button. A sample copy prints immediately. The sample copy is not counted as
part of the print job.

6. Print the remaining copies or delete the job.
—  To print the remaining copies of the job, touch Release.
—  If the sample copy is unsatisfactory, touch Delete.
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Saving Copy Settings

To use a particular combination of copy settings for future copy jobs, you can save the settings with a
name and retrieve them for later use.

To save the current copy settings:

1. Press the Services Home button, then touch Copy.

2. Touch the Job Assembly tab, then touch Save Current Settings.

3. Using the touch screen keyboard, type a name for the saved settings.
4. Touch OK.

Retrieving Saved Copy Settings

You can retrieve and use any previously saved copy settings for current jobs.

Note: To save the copy settings with a name, see Saving Copy Settings on page 116.

To retrieve saved settings:

1.  Press the Services Home button, then touch Copy.

2. Touch the Job Assembly tab, then touch Retrieve Saved Settings.
3. Touch the desired saved setting.

Note: To delete a saved setting, touch the setting, then touch Delete Settings.

4. Touch Load Settings. The saved settings are loaded for the current copy job.
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ID Card Copying

This section includes:
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e Selecting Color or Black and WHit@ COPIES......vemririennineeneissisissisessssssisessesssssssssssssssssssssssssssssssessssssssens 118
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Copying an ID Card

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied
using the same location on the document glass. The printer stores both sides and prints them side by
side on the paper.

To copy an ID card:

Press the Services Home button, then touch ID Card Copy.

Touch the ID Card Copy tab.

Verify the output color, paper supply, and reduce/enlarge settings. Change the settings as needed.
Touch the Image Quality tab.

s whN =

Verify the original type, lighten/darken, and background suppression settings for side 1. Change the
settings as needed.

o

Lift the document cover.

7. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left
corner of the document glass.

8. Press the green Start button.
9. Lift the document cover.
10. Turn over the document and position it in the upper left corner of the document glass.

11. Verify the original type, lighten/darken, and background suppression settings for side 2. Change the
settings as needed.

12. Press the green Start button.
13. Lift the document cover and remove the ID card or document.
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Selecting Color or Black and White Copies
If the original document contains color, you can create color or black and white copies.

To select the output color:

1. Press the Services Home button, then touch ID Card Copy.
2. Touch the ID Card Copy tab.

3. Under Output Color, select an option:

—  Color: This option copies in full color output using all four printing colors, cyan, magenta,
yellow, and black.

—  Black and White: This option copies in black and white only.

Reducing or Enlarging the Image
You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 %.

To reduce or enlarge the image:
1.  Press the Services Home button, then touch ID Card Copy.
2. Touch the ID Card Copy tab.
3. Under Reduce/Enlarge, touch an option:
—  Toreduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-).

—  Toreduce or enlarge the percentage using the alphanumeric keypad to type a specific value,
touch the current displayed value.

— Touse a preset value, touch the corresponding button.
4.  Touch More for additional options.
—  Toreduce or enlarge proportionally, touch Proportional %.
e Toreduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-).

e Toreduce or enlarge the percentage using the alphanumeric keypad, touch the current
displayed value.

e  Presets (X-Y%) allow you to select from a list of preset values. Touch More for additional
preset values.

—  Toreduce or enlarge the width and length of the image by different percentages, touch

Independent %.

e  Width:X% allows you to reduce or enlarge the width of the image incrementally using the
alphanumeric keypad or the Plus (+) and Minus (-) buttons.

e Length:Y% allows you to reduce or enlarge the length of the image incrementally using
the alphanumeric keypad or the Plus (+) and Minus (-) buttons.

e  Presets (Y/X) allow you to select from a list of preset values. Touch More for additional
preset values.

5. Touch OK.
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Selecting the Paper Tray

To make copies on Letterhead, colored paper, or different paper sizes, you load the desired paper into
any tray, then select the tray as the source for your copy job.

To select the tray to use for ID card copies:

1. Press the Services Home button, then touch ID Card Copy.
2. Touch the ID Card Copy tab.

3. Under Paper Supply, touch the desired tray.

Specifying the Original Type

The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

To specify the original type:

1. Press the Services Home button, then touch ID Card Copy.

2. Touch the Image Quality tab.

3.  Onthe Original Type screen, select the setting that matches your original document best.

Lightening or Darkening ID Card Copies

You can lighten or darken the copy for each side. Use the slider to lighten or darken the output for the
first side. After the first side is complete, use the slider again to lighten or darken the second side. Both
sides of the original are printed side by side, each using different lighten or darken settings.

To adjust the image:

1. Press the Services Home button, then touch ID Card Copy.

2. Touch the Image Quality tab.

3. Tolighten or darken the image for side 1, under Lighten/Darken, adjust the slider up or down.

4.  Lift the document cover.

5. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left
corner of the document glass.

6. Press the green Start button.

7. Lift the document cover.

8. Turn over the document and position it in the upper left corner of the document glass.

9. Tolighten or darken the image for side 2, adjust the slider up or down.

10. Press the green Start button.

11. Lift the document cover and remove the ID card or document.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To change this setting:

1. Press the Services Home button, then touch ID Card Copy.

2. Touch the Image Quality tab.

3. Under Background Suppression, touch Auto Suppression.
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This chapter includes:
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The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide at www.xerox.com/office/WC6655docs.

If the system administrator enables Remote Start in CentreWare Internet Services, you can scan images
directly from the scanner to a PC. Using Microsoft Clip Organizer, you can scan, import, and store images
from the printer. You can also scan directly from the printer to a computer using most TWAIN-compliant
scanning applications.
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Basic Scanning

The Scanning feature provides several methods for scanning and storing an original document. The
scanning procedure using your printer differs from that of desktop scanners. The printer is connected
typically to a network rather than a single computer, so you select a destination for the scanned image
at the printer.

The printer supports the following scanning functions:

e Scan documents and store images on the printer hard drive.

e  Scan original documents to a document repository on a network server.
e Scan original documents to an email address.

e Scan original documents to your home directory.

e Scan original documents to a USB Flash drive.

e Import scanned images into applications using TWAIN and WIA.

To scan an image:
1. On the control panel, press the yellow Clear All button to clear previous settings.
2. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

3. Press the Services Home button, then touch Workflow Scanning.

4. Touch the Down arrow, then select the template group from the menu.

5. Select a template from the list.

6. To change any of the scan settings, use the options at the bottom of the touch screen:
—  Output Color
—  2-Sided Scanning
—  Original Type

—  Scan Presets
For details, see Changing the Basic Scan Settings on page 131.
7. Press the green Start button.

Notes:

e The printer must be connected to a network to retrieve a scan file remotely.
e  For details, see the Help in CentreWare Internet Services.

e  Print, copy, and fax jobs can print while you are scanning original documents or downloading files
from the printer hard drive.
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Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

e Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14 in.).

Document Glass Guidelines

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex
automatic document feeder.

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

e  Coated or carbonless paper or items other than paper such as cloth or metal
e Envelopes

e Books

Document Feeder

e Insert originals face up, with page one on top.

e The confirmation indicator illuminates when
you load the originals correctly.

e Adjust the paper guides so they fit against the
originals.

e The document feeder supports paper weights
of 50-125 g/m?for 1-sided pages, and
60-125 g/m?for 2-sided pages.

e The document feeder supports paper sizes
from 139.7 x 139.7 mm (5.5x 5.5 in.)
through 215.9 x 355.6 mm (8.5 x 14 in.).

e The maximum document feeder capacity is
approximately 60 sheets of 80 g/m? paper.
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Duplex Automatic Document Feeder Guidelines

When loading originals into the duplex automatic document feeder, follow these guidelines:

e Insert originals face up with the top of the page entering the feeder first.

e  Only place loose sheets of paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the originals.

e  Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
e Do not load originals above the MAX fill line.
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Scanning to a Folder

This section includes:
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Scanning to a folder is the simplest scanning method. When you scan an image at the printer, the scan
file is stored in a folder on the internal hard drive. You then use CentreWare Internet Services to retrieve
the stored scan file to your computer.

The default settings create a 1-sided color portable document format (.pdf) file. You can change these
settings using the printer control panel, or using CentreWare Internet Services at your computer. Control
panel selections override the settings in CentreWare Internet Services.

Scanning to the Public Folder

The printer provides a public folder to store scanned images. You do not need a password to scan images
to the public folder, or to retrieve them. All users can view scanned documents in the public folder. You
can also create a password-protected private folder. For details, see Creating a Private Folder on page
126.

To scan an image to the public folder:

1. Load the original on the document glass or in the document feeder.

Press the Services Home button, then touch Workflow Scanning.

Touch the Down arrow, then select All Templates from the menu.

From the list, select the Default folder.

To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.

6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on
page 131.

7. Press the green Start button. The Job Progress screen appears, and the original is scanned. The file
is stored on the printer hard drive.
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8. Use CentreWare Internet Services to move the file to your computer. For details, see Retrieving Scan
Files on page 127.
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Scanning to a Private Folder

The system administrator creates private folders on the printer. Private folders can require a password.
You can use CentreWare Internet Services to create your own private folders. For details, see Creating a
Private Folder on page 126.

To scan to a private folder:

1.
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Load the original on the document glass or in the document feeder.
Press the Services Home button, then touch Workflow Scanning.
Touch the Down arrow, then select All Templates from the menu.
From the list, select the private folder.

On the Document Management screen, touch Enter Password for Folder, then use the touch screen
keyboard to enter the password as needed.

Touch Done.
Touch OK.
Press the green Start button.

Creating a Private Folder

For you to create a private folder, the scan policy to allow additional folders to be created must be
enabled. The system administrator can create a private folder at any time. For details on enabling or
disabling Scan to Mailbox, see the System Administrator Guide for your printer model.

To create a private folder with a password:

1.
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At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer
on page 29.

Click the Scan tab.

In the Display section, select Mailboxes.

Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, see the
System Administrator Guide at www xerox.com/office/WC6655docs.

In the Scan to Mailbox section, click Create Folder.

Click the Folder Name: field, then type a name for the folder.

In the Folder Password field, type a password that adheres to the password rules.

In the Confirm Folder Password field, type the password again.

Click Apply.

Your private folder appears in the folder list in CentreWare Internet Services and on the printer
touch screen under Local Templates. The contents are stored on the printer hard drive.
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Retrieving Scan Files

To retrieve your scanned images, use CentreWare Internet Services to copy the scan files from the
printer to your computer.

To retrieve your scan files:

1.

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 29.

Click the Scan tab.

In the Display section, select Mailboxes.

In the Scan to Mailbox section, click the folder containing the scan.
Your scan file appears in the Folder Contents window.

Notes:

e For apassword protected private folder, click the Folder Password field, type the password, then
click OK.

e If yourimage file does not appear, click Update View.

Under Action, select an option, then click Go.

— Download saves a copy of the file to your computer. When prompted, click Save, then navigate
to the location on your computer to save the file. Open the file or close the dialog box.

—  Reprint prints the file without saving a copy of the file to your computer.

— Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel
to cancel the operation.
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Scanning to Network File Repositories

This section includes:
e Scanning to a Predefined Network File REPOSILOrY ... s ssssssssssssenns 128
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When using this feature, the images you scan are sent to a file repository on a network server. The
system administrator configures the file repository settings.

Using CentreWare Internet Services, you can add your own scan destinations to templates.

Scanning to a Predefined Network File Repository

To scan an image and send it to a predefined network file repository:

1. Load the original on the document glass or in the document feeder.

Press the Services Home button, then touch Workflow Scanning.

Touch the Workflow Scanning tab.

Touch the Down arrow, then select All Templates from the drop-down menu.

From the list, select the template that the system administrator created. The template defines the
scan settings as well as the destination of the image.
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6. To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.
7. Press the green Start button.
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Adding a Scan Destination

1.
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11.

12.

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Click the Scan tab.
In the Display areaq, select Templates.
Under Template Operations, click Create New Template.

In the New Distribution Template area, under Add Destination to Template, click Enter a Scan
Destination.

Click the Friendly Name: field, then create a name for the template.
Under Protocol, select an option.
Configure the destination IP Address: Port number or Host Name: Port number.

Enter the name of the destination folder as needed. In SMB, the destination folder is the shared
folder.

In Document Path, enter the name of the sub folder within the destination folder, then select a
Filing Policy.
Enter a valid login name and password.

Note: Use the login name for the computer that holds the destination folder. The login name can
include the domain name also, such as domain name\login name.

Click Add. The template is stored on the printer hard drive.
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Scanning to Your Home Directory

The Scan to Home feature allows you to scan an image to your home directory.

Note: To use the Scan to Home function, you must log in with a valid user name and passcode. For
details, see Logging In on page 27.

To scan an image to your home directory:

1. Load the original on the document glass or in the document feeder.

Press the Services Home button, then touch Workflow Scanning.

Touch the Down arrow, then select Scan to Home Templates from the menu.
From the list, select the template that the system administrator created.
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To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.

6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on
page 131.

7. Press the green Start button.
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Setting Scan Options

This section includes:

Changing the BASIC SCAN SETLINGS ...t sssssssssssssssssssssessssssssasssssssssssssssssssssesanes 131
Selecting AAVANCEA SELLINGS ...ttt ssss s sssssss st s s st s s s s basssssssss s s s sass s sanes 131
Selecting LaYOUTL AQJUSTIMENTS ...t ssssessssss s s ssssssssssssssssssssssssssssassssssssssssssssssnssssssnssanns 133
SeleCting FiliNG OPLIONS ...ttt sss s ssss st s sss s s essssasesessssssssssssssassssasessnes 133
BUILAING O SCAN JOD ettt s st ssss s s s ssss s sasssss et ssssss st s ssssssssssssassesssssassansesssanns 134

The scanning features in your printer use templates that define the scan settings and the destination for
an image.

Changing the Basic Scan Settings

To change the basic scan settings:

1.
2.

Press the Services Home button, then touch Workflow Scanning.
Touch Output Color, then select an option.

—  Black and White: Scans in black and white only.

—  Grayscale: Detects and scans various shades of gray.

—  Color: Scans in full color.

Touch 2-Sided Scanning, then select an option.

— 1-Sided Scan: Scans only one side of the original document or image and produces 1-sided
output files.

—  2-Sided Scan: Scans both sides of the original document or image.

—  2-Sided Scan, Rotate Side 2: Scans both sides of the original document or image, and rotates
the second side by 180 degrees.

Touch Original Type, then select an option.
Touch File Name, type a name for the scan file, then touch OK.

Selecting Advanced Settings

Advanced settings allow you to control image options, image enhancements, scan resolution, file size,
and updating of templates.

To select advanced settings:

1.
2.

Press the Services Home button, then touch Workflow Scanning.
Touch the Advanced Settings tab.
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To adjust brightness, sharpness, and saturation:
a. Touch Image Options.
b. On the Image Options screen, adjust the sliders as needed:
e Lighten/Darken lightens or darkens the image.
e Sharpness sharpens or softens the image.
e Saturation makes the image colors more vivid or pastel.
c. Touch OK.
To suppress background variation:
a. Touch Image Enhancement.
b. Under Background Suppression, touch Auto Suppression.
c¢. Touch OK.
To adjust the contrast:
a. Touch Image Enhancement.
b. Onthe Image Enhancement screen, select an option:
e Auto Contrast allows the printer to set the contrast automatically.

e  Manual Contrast allows you to adjust the contrast manually. Move the Manual Contrast
slider up or down to increase or decrease the contrast. The middle position on the slider,
Normal, does not change the contrast.

c¢. Touch OK.

To select scan presets:

a. Touch Scan Presets.

b. Select an option.

c. Touch OK.

To set the resolution:

a. Touch Resolution.

b.  On the Resolution screen, select a resolution from 72 dpi through 600 dpi.
c. Touch OK.

To set the quality and file size:
a. Touch Quality/File Size.

b.  On the Quality/File Size screen, use the slider to select a setting. The settings range from
Normal Quality and Small File Size to Highest Quality and Largest File Size.

c. Touch OK.

To retrieve new templates and remove outdated ones:
a. Touch Update Templates>Update Now.

b. Touch Update Now.

c. Touch Close.
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Selecting Layout Adjustments

Layout adjustments provide additional settings for the size and orientation of the original, and erasing
the edges.

To select layout adjustments:

1. Press the Services Home button, then touch Workflow Scanning.

2. Touch the Layout Adjustment tab.

3. To specify the orientation of the original image, touch Original Orientation, then select an option.

4. Touch OK.

5. To scan the correct area of the original image, touch Original Size, then select an option.
Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

6. Touch OK.

7. To specify the amount to erase from the edges of your image, touch Edge Erase, then select an
option.

8. Touch OK.

9. To manage how the scanner processes blank pages, touch Blank Page Management, then select an
option.

10. Touch OK.

Selecting Filing Options

Filing Options provide additional settings for naming images, selecting image formats, and selecting
behavior when a file name exists.

To select filing options:

1.
2.
3.

Press the Services Home button, then touch Workflow Scanning.

Touch the Filing Options tab.

To select a file format:

a. Touch File Format.

b.  On the File Format screen, under Format, select an option.

¢.  Under Options, for PDF, PDF/A, XPS, or TIFF, select an option:
e  Multi-page creates a multi-page document from the scanned images.
e 1 File Per Page creates a separate file for each page scanned.

d. Under Options, for PDF, PDF/A, or XPS, select an option:
e Image Only creates an unsearchable image of the scanned document.
e Searchable creates a searchable document of the scanned pages.

e. For the searchable option, select a language from the drop-down menu.

f.  Touch OK.
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4. To select the action to take if a file already exists:
a. Touch If File Already Exists.
b.  On the If File Already Exists screen, select an option.
c. Touch OK.
5. To define additional network locations as destinations for scanned documents:
a. Touch Add File Destinations.
b. On the Add File Destinations screen, touch the desired destinations.
c. Touch OK.
Note: Document Management and Add File Destinations can be modified only after scanning to

network file repositories or scanning to home are set up. For details, see the System Administrator
Guide at www.xerox.com/office/WC6655docs.

Building a Scan Job
Use this feature to combine an assorted group of originals for assembly into a single scan job.

To build a scan job:
1. Press the Services Home button, then touch Workflow Scanning.
2. Touch the Job Assembly tab, then touch Build Job>On.
3. Touch Options.
a. Select or clear the Display this window between segments check box.
b. Select or clear the Turn Build Job Off after Job is Submitted check box.
4. Program and scan the first segment:
a. Load the originals for the first segment.
b. Press the green Start button on the control panel.

Note: If a password is required, contact the system administrator.

5. Program and scan additional segments:
a. Load the originals for the next segment.
b. When the Build Job screen appears, touch Program Next Segment.
c. Pressthe green Start button to scan the originals for that segment.
6. Repeat the previous step for each remaining segment.

Note: At any time, you can touch Delete All Segments to modify the job.

7.  When all of the segments have been programmed and scanned, touch Submit the Job. The Job
Progress screen appears, and the individual segments are scanned as a single job.

Note: If necessary, touch Delete>Delete Job to cancel the job.
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Scanning to a USB Flash Drive

1. Load the original on the document glass or in the document feeder.

2. Insert your USB Flash drive into the USB port on the side of the printer.
Note: If the USB Flash drive is already in the USB memory port, press Services Home, then touch
Workflow Scanning>Scan to USB.

3. Onthe USB Drive Detected screen, touch Scan to USB.

4. To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.

5. Press the green Start button.

The Job Progress screen appears, and the original is scanned. The file is stored on your USB Flash
drive.

6. Remove your USB Flash drive from the printer.
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Scanning to an Email Address

This section includes:
e Sending a Scanned Image to an EMQIL AAAIESS .......o.ereerrnrineneinesrissisissessissssessssssssssssssssssssssssssseens 136
®  SEtliNg EMQAIl OPLIONS ...ttt sesssses b s sesssss s ssss st ssss b ss st s s s b st sass st s bass b st s s sassssnsens 137

When using this feature, the images you scan are sent as email attachments.

Sending a Scanned Image to an Email Address

Before scanning to email, configure the email SMTP and From Field properties. You must have at least
one email address in the address book. If email properties are not properly configured, the Email icon
appears grayed out on the touch screen.

To scan an image and send it to an email address:
1. Load the original on the document glass or in the document feeder.
2. Press the Services Home button, then touch Email.
3. To enter an email address:
a. Touch New Recipient.
b.  Touch the Down arrow, then select To: or Cc: or Bec: from the menu.

¢. Touch the Enter email address and select Add field, then use the touch screen keyboard to
type the email address.

d. Touch Add.
e. Use the touch screen keyboard to type additional email addresses.
f.  When you are finished, touch Close.
4. To enter an email address from the network address book:
a. Touch Address Book.
b. Use the touch screen keyboard to type part of the name, then touch Search.
c. Select the desired name from the list, then touch Add.
d. Touch Close.
5. Toadd asubject line:
a. Touch Subject, then use the touch screen keyboard to type the desired text.
Note: To modify the default subject, highlight the text in the text field, then touch X to delete it, or
type over the existing text.
b. Touch OK.
6. To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.
7. Press the green Start button.
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Setting Email Options

You can change the following email settings:

File Name
File Format
Message
Reply To

To change the email options:

1.
2.
3.

Load the original on the document glass or in the document feeder.
Press the Services Home button, then touch Email.
To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.
Touch the Email Options tab.
Change the file name.
Touch File Name.
a. On the File Name screen, use the touch screen keyboard to delete or modify the default text.
b. Touch Save.
Change the file format and options:
a. Touch File Format.
b. On the File Format screen, under Format, select an option.
c.  Under Options, for PDF, PDF/A, XPS, or TIFF, select an option:
¢  Multi-page creates a multi-page document from the scanned images.
e 1 File Per Page creates a separate file for each page scanned.
d. Under Options, for PDF, PDF/A, or XPS, select an option:
e Image Only creates an unsearchable image of the scanned document.
e Searchable creates a searchable document of the scanned pages.
e. For the searchable option, select a language from the drop-down menu.
f.  Touch OK.
Change the message:
a. Touch Message.
b. On the Message screen, use the touch screen keyboard to type a message to appear with the
images.
c. Touch OK.
Change the Reply To address:
a. Touch Reply To.
b. On the Reply To screen, use the touch screen keyboard to type an email address.
c. Touch OK.

10. Press the green Start button.
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Scanning to a Destination

This section includes:
e Sending a Scanned IMage to A DeStINALION........covverierrerree st s st ssssssessssessssssesens 138

Use Scan to Destination to send scanned images to a remote destination, such as an FTP server or a
personal computer.

Sending a Scanned Image to a Destination

Before scanning to a destination, configure the destination folders on the server or share the folder on a
personal computer. In addition, you must have at least one Scan To Destination in the address book. If
Scan To Destination properties are not properly configured, the Scan To icon appears grayed out on the
touch screen.

To scan an image and send it to a destination:

1. Load the original on the document glass or in the document feeder.

2. Press the Services Home button, then touch Scan To.

3. On the Device Address Book page, select Scan Contacts or Scan Favorites.

Note: If the Device Address Book does not appear, press the Clear All button and start over.

In the Names list, touch a destination, then touch Add to Recipients.

Repeat steps 3 and 4 for each destination as needed.

Touch OK.

To change any of the scan settings, use the options at the bottom of the touch screen.
For details, see Changing the Basic Scan Settings on page 131.

8. Press the green Start button.

The Job Progress screen appears, and the original is scanned. The file is stored as a file at the
destination.

No v e
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This chapter includes:
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The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide at www.xerox.com/office/WC6655docs.
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Basic Faxing

You can send a fax in one of four ways:
e Fax, or embedded fax, scans the document and sends it directly to a fax machine.

e Server Fax scans the document and sends it to a fax server, which transmits the document to a fax
machine.

e Internet Fax scans the document and emails it to a recipient.
e LAN Fax sends the current print job as a fax. For details, see the print driver software.

To send a fax:
1. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

2. Press the Services Home button, then touch the appropriate fax.
3. Address the fax using one or more of the available options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Save.

Note: One or more dialing pauses can be required between the access number for an outside line
and the fax number. When inserted, the dial pauses appear as commas in the fax number.

—  Favorites allows you to access selected favorite individual or group contacts from the address
book.
— Address Book allows you to access the printer address book.
4. On the Fax tab, adjust the available fax options as needed.

5. Adjust additional fax options as needed. For details, see Selecting Fax Options on page 145,
Selecting Server Fax Options on page 154, or Selecting Internet Fax Options on page 158.

6. Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

e Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14 in.).

Document Glass Guidelines

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.).

To copy or scan the following types of originals, use the document glass rather than the duplex
automatic document feeder.

e  Paper with paper clips or staples attached

e  Paper with wrinkles, curls, folds, tears, or notches

e  Coated or carbonless paper or items other than paper such as cloth or metal
e Envelopes

e Books

Document Feeder

e Insert originals face up, with page one on top.

e The confirmation indicator illuminates when
you load the originals correctly.

e Adjust the paper guides so they fit against the
originals.

e The document feeder supports paper weights
of 50-125 g/m?for 1-sided pages, and
60-125 g/m?for 2-sided pages.

e The document feeder supports paper sizes
from 139.7 x 139.7 mm (5.5x 5.5 in.)
through 215.9 x 355.6 mm (8.5 x 14 in.).

e The maximum document feeder capacity is
approximately 60 sheets of 80 g/m? paper.

Xerox® WorkCentre® 6655 Color Multifunction Printer 141
User Guide



Faxing

Duplex Automatic Document Feeder Guidelines

When loading originals into the duplex automatic document feeder, follow these guidelines:

e Insert originals face up with the top of the page entering the feeder first.

e  Only place loose sheets of paper in the duplex automatic document feeder.

e Adjust the paper guides so that they fit against the originals.

e  Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
e Do not load originals above the MAX fill line.
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Sending an Embedded Fax

1. Load the original document in the document feeder or on the document glass.
2. Press the Services Home button, then touch Fax.
3. To address the fax, touch one or more options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Add. Add more
numbers, or touch Close.

Note: One or more dialing pauses can be required between the access number for an outside line
and the fax number. When inserted, the dial pauses appear as commas in the fax number.

—  Favorites allows you to access selected favorite individual or group contacts from the address
book.

— Address Book allows you to select fax numbers from your Address Book. Touch the Down
arrow, then select Individual or Group from the drop-down menu. Touch the Up or Down
arrows to scroll through the list, touch the desired contact, then select Add to Recipients from
the drop-down menu. Select and add more contacts, or touch Close.

4.  Toinclude a cover sheet:
a. Touch Cover Sheet>On.

b. Touch the To field, use the touch screen keyboard to type the name of the recipient, then touch
Save.

c.  Touch the From field, use the touch screen keyboard to type the name of the sender, then
touch Save.

d. Toadd a comment, do one of the following:
e Touch an existing comment, then touch Save.

e Touch an <Available> comment, touch Edit, use the touch screen keyboard to type the
text, then touch Save.

Notes:

e To delete an existing comment, touch the comment, then touch Clear. Touch Clear to confirm the
action.

e To edit an existing comment, touch the comment, then touch Edit. Use the touch screen keyboard
to change the comment, then touch Save.

5. Touch 2-sided Scanning and select an option.
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Touch Original Type and select an option.
Touch Resolution and select an option.
Select more options as needed. For details, see Selecting Fax Options on page 145.

Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.

L e N

Note: To pause the job, press the Stop button. On the touch screen, touch Resume Scanning to
continue the job, or Cancel Scanning to cancel the job completely. If you do not make a selection
within 60 seconds, the job automatically resumes.
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Selecting Fax Options

This section includes:
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Adjusting Brightness and Sharpness

You can lighten or darken the image, and adjust the sharpness.

To adjust the image:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Image Quality tab, then touch Image Options.
On the Image Options screen, adjust the sliders as needed:
— Lighten/Darken lightens or darkens the image.

—  Sharpness sharpens or softens the image.

Touch OK.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1.

2.
3.
4

Press the Services Home button, then touch Fax.

Touch the Image Quality tab, then touch Image Enhancement.
Under Background Suppression, touch Auto Suppression.

Touch OK.

Adjusting the Contrast

Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1.
2.
3.

Press the Services Home button, then touch Fax.
Touch the Image Quality tab, then touch Image Enhancement.
On the Image Enhancement screen, select an option:

—  Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move
the slider up or down to increase or decrease the contrast. The middle position on the slider,
Normal, does not change the contrast.

—  Auto Contrast allows the printer to set the contrast automatically.

Touch OK.

Specifying the Size of the Original

To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:

1.
2.
3.

146

Press the Services Home button, then touch Fax.

Touch the Layout Adjustment tab, then touch Original Size.

On the Original Size screen, select an option:

—  Auto Detect: This options allows the printer to determine the size of the original.

Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

—  Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areaq, touch the Length (Y) and Width (X) arrows.

Touch OK.
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You can determine the method to use for handling images that are too large.

To select reducing or splitting:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Layout Adjustment tab, then touch Reduce/Split.

Touch an option:

—  Reduce to Fit shrinks large documents to fit on smaller paper.

—  Split Across Pages continues a single image across several pages.
Touch OK.

Setting Up Book Faxing

You can determine the method used for scanning images in a book.

To select book faxing:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Layout Adjustment tab, then touch Book Faxing.

Touch an option:

—  Offis the default setting.

—  Both Pages scans both pages of the book.

—  Left Page Only scans the left page of the book.

— Right Page Only scans the right page of the book.

To set the amount to erase, touch the Binding Edge Erase arrows as needed.
Touch OK.

Printing a Confirmation Report

You can print a report that confirms when your faxes are sent or received. The report contains
information on timeouts, busy signals, and retry failures.

To set up a confirmation report printing:

1.
2.
3.

Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Confirmation Report.

Touch an option:

—  Always Print generates a report for all fax jobs.

—  Print on Error Only generates a report only for fax jobs that fail to send.
Touch OK.
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Selecting the Starting Rate

Select the highest starting rate unless the destination for the fax you are sending has special
requirements.

To select the transmission speed for a fax:

1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Starting Rate.
3. Touch an option.

4, Touch OK.

Note: Some telephone networks can require you to set the fax starting rate to Forced (4800 bps).
The slower data rate ensures a more reliable transmission of data.

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. The delay can range from 15
minutes through 24 hours.

Note: Before using this feature, set the printer to the current time.

To specify the time to send your fax:
1. Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Delay Send.
3. Touch Specified Time.
—  Touch the Hour field, then touch the arrows to set a number.
—  Touch the Minute field, then touch the arrows to set a number.
—  If your printer is set to display the 12-hour clock, touch AM or PM.
4.  Touch OK.
The fax is sent at the specified time.

Sending Header Text

The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide at www.xerox.com/office/WC6655docs.

To include the fax header text:

1.  Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Send Header Text.
3. Touch an option.

4. Touch OK.
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Sending a Fax to a Remote Mailbox

1. Press the Services Home button, then touch Server Fax.
2. Touch the Fax Options tab, then touch Mailboxes.

3. Touch Send to Remote Mailbox.

4. To address the fax, select an option:

—  The Fax Number field allows you to enter a fax number. Use the alphanumeric keypad to enter
the number, then touch Add.

— Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Save.

5. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

6. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

7. Touch OK.

Storing a Fax in a Local Mailbox

The system administrator must create a mailbox before you can use this feature. For details, see the
System Administrator Guide at www.xerox.com/office/WC6655docs.

To store a fax in a local mailbox:
1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Mailboxes.

3. Touch Store to Local Mailbox.

4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

5.  Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

6. Touch OK.

Printing Local Mailbox Documents

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a
Local Mailbox on page 149.

To print local mailbox documents:

1.  Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Print Local Mailbox Documents.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

- whN

6. Touch Print All Documents. The documents in the mailbox are printed.
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Deleting Local Mailbox Documents

1.

nwntwheN

Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Delete Local Mailbox Documents.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

Touch Delete All Documents.
To confirm, touch Delete All. All documents in the mailbox are deleted.

Storing a Fax for Local or Remote Polling

Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that
are allowed to access the stored faxes on the printer.

To store a fax:

1.
2.
3.

150

Press the Services Home button, then touch Fax.
Touch the Fax Options tab, then touch Local Polling.
Under Store for Local Polling, touch one of the following options:

—  Non-Secure Polling scans your originals and stores them as documents. Anyone with this fax
number can access the documents.

—  Secure Polling scans your originals and stores them as documents. You specify the fax
numbers that can access the documents.

For secure polling, touch one or more of the following to add fax numbers to the access list:

—  Fax Number field allows you to enter a fax number manually. Use the alphanumeric keyboard
to enter the number, and touch Add.

— Address Book allows you to add individual stored fax numbers to the list. Select a fax number,
and select Add to Recipients from the drop-down menu. Touch Close.

—  The Allow all Address Book fax numbers access check box adds all stored fax numbers to the
list.

Note: To modify existing entries in the access list, touch the entry, then select Edit, Remove, or
Remove All from the drop-down menu.

Touch Save.
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Printing or Deleting Secure Faxes

1.  Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Local Polling.
3. Under Store for Local Polling, touch an option:
—  Print All Stored Documents prints all stored fax documents.

—  Delete All Stored Documents deletes all stored fax documents. To confirm the action, touch
Delete All.

Polling a Remote Fax

If remote polling is turned on, you can retrieve documents that were stored using local polling on
another fax machine.

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch
Local Polling>Off>Save.

To poll a remote fax:

1.  Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Remote Polling.
3. Under Poll, touch Remote Fax.

4. To address the fax, select one or more options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch + (Add).

— Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Close.

5. Toset atime for the printer to retrieve faxes from other fax machines, do the following:
a. Touch Delay Poll.
b. To set the time, touch Delay Poll.
e  Touch the Hour field, then touch the arrows to set a number.
e Touch the Minute field, then touch the arrows to set a number.
e If your printer is set to display the 12-hour clock, touch AM or PM.
c. Touch OK.
6. To retrieve and print the faxes, touch Poll Now.

Note: To cancel, touch Close.
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Building a Fax Job

Use this feature to fax an assorted group of originals, each with different settings. Each segment is
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have
been stored, the individual segments are faxed as a single job.

To build a fax job:
1. Press the Services Home button, then touch the appropriate fax.
2. Address the fax using one or more of the available options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Save.

—  Address Book allows you to access the printer address book.

—  Favorites allows you to access selected favorite individual or group contacts from the address
book.

3. Touch the Job Assembly tab, then touch Build Job>On.
4. Touch Options.
a. Select or clear the Display this window between segments check box.
b. Select or clear the Turn Build Job Off after Job is Submitted check box.
5. Program and scan the first segment:
a. Load the originals for the first segment.
b. Select the required settings, such as layout adjustments, image quality, and options.
c. Press the green Start button on the control panel.
6. Program and scan additional segments:
a. Load the originals for the next segment.
b. When the Build Job screen appears, touch Program Next Segment.
c. Using the appropriate tabs, select the required settings.
d. Pressthe green Start button to scan the originals for that segment.
7. Repeat the previous step for each remaining segment.

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job.

8. When all of the segments have been programmed and scanned, touch Submit the Job. The Job
Progress screen appears, and the individual segments are faxed as a single job.

9. On the Job Progress screen, touch Job Details to view a summary of the job.

Note: If necessary, touch Delete>Delete Job to cancel the job.
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Sending a Server Fax

If a fax server is connected to the network, you can send a document to a fax machine without requiring
a dedicated telephone line.

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax
server then sends the fax over a telephone line to a fax machine.

The system administrator must enable the server fax service and configure a fax repository, or filing
location, before you can use this feature.

To send a server fax:

1. Load the original on the document glass or in the duplex automatic document feeder.
2. Press the Services Home button, then touch Server Fax.

3. To address the fax, touch one or more options:

—  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

— Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use
the touch screen keypad to enter the numerals and characters, then touch Add. Add more
numbers, or touch Close.

—  Fax Directory allows you to select fax numbers from your Fax Directory. Touch the Up or Down
arrows to scroll through the list, touch the desired contact, then select Add to Recipients from
the drop-down menu. Select and add more contacts, or touch Close.

Touch 2-sided Scanning and select an option.

Touch Original Type and select an option.

Touch Resolution and select an option.

Select more options as needed. For details, see Selecting Server Fax Options on page 154.

© N o &

Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Selecting Server Fax Options

This section includes:

®  AQJUSEING BIIGNENESS ...ttt sessssss s sssssss s s s s s s bbb s b s s b bass bbbt s s saesssnsens 154
e Automatically Suppressing Background VaAriation..........c..ceeerercneerenrinsnsensinsssiseesesssssssssssesssssssssssens 154
®  AdJUSEING the CONTIAST ...ttt ss et bt ss s st ssse st s sasessssssnsans 155
o  Specifying the Orientation Of the OFgINGL...... st ssssesssssssssssesssans 155
o Specifying the Size Of the OFiGINGL. ...ttt sssssssssssssssssssss s ssssssssssssssssnssnns 155
0 SeNAING O DEIAYEA FOX currruririerrirriirrrirsisieieeiiseiseississesssssssssas s ssssssssssssasssssssssssssssssssessessssssssssssssesssssssssssassssesssssans 156
®  BUILAING O FOX JOD ottt stsssas s bsssassssss s s s s s st s bbb s b st s sass bbb s e bass s sa s s s e 156

Adjusting Brightness
You can lighten or darken the image.

To adjust the image:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Options.

3. On the Image Options screen, adjust the Lighten/Darken slider up or down as needed.
4.  Touch OK.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4, Touch OK.
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Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. On the Image Enhancement screen, select an option:

—  Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move
the slider up or down to increase or decrease the contrast. The middle position on the slider,
Normal, does not change the contrast.

—  Auto Contrast allows the printer to set the contrast automatically.
4, Touch OK.

Specifying the Orientation of the Original

1. Touch the Layout Adjustment tab, then touch Original Orientation.
2. On the Original Orientation screen, touch the desired orientation:

— Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

—  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning it
over.

3. Touch OK.

Specifying the Size of the Original
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:
1. Press the Services Home button, then touch Server Fax.
2. Touch the Layout Adjustment tab, then touch Original Size.
3.  On the Original Size screen, select an option:
—  Auto Detect: This options allows the printer to determine the size of the original.

Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

—  Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areaq, touch the Length (Y) and Width (X) arrows.

4. Touch OK.
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Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. The delay can range from 15
minutes through 24 hours.

Note: Before using this feature, set the printer to the current time.

To specify the time to send your fax:
1. Press the Services Home button, then touch Server Fax.
2. Touch the Fax Options tab, then touch Delay Send.
3. Touch Specified Time.
a. Touch the Hour field, then touch the arrows to set a number.
b. Touch the Minute field, then touch the arrows to set a number.
c. If your printer is set to display the 12-hour clock, touch AM or PM.
4. Touch OK.
The fax is sent at the specified time.

Building a Fax Job

For details, see Building a Fax Job on page 152.
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Sending an Internet Fax

If an SMTP (email) server is connected to the network, a document can be sent to an email address. This
feature eliminates the need for a dedicated telephone line and the associated service costs. When
sending an Internet Fax, the document is scanned and sent to an email address.

To send an Internet fax:

1.
2.
3.

Load the original on the document glass or in the document feeder.
Touch the Services Home button, then touch Internet Fax.

To address the fax:

a. Touch New Recipient.

b. Touch the Down arrow, then from the menu, select To: or Cc..

¢. Touch the Enter email address and select Add field, then use the touch screen keyboard to
type the email address.

d. Touch Add.

e. Use the touch screen keyboard to type additional email addresses.

f.  When you are finished, touch Close.

To add a subject line:

a. Touch Subject, then use the touch screen keyboard to type the desired text.

Note: To modify the default subject that appears, touch X to clear the field.

b. Touch OK.
Adjust the Internet fax options as needed.
a. Touch 2-sided Scanning and select from the drop-down menu:
e 1-Sided
e 2-Sided
e 2-Sided, Rotate Side 2
b. Touch Original Type and select from the drop-down menu:
e Photo & Text

e Photo
e Text
e Map

¢ Newspaper/Magazine
Adjust additional fax options as needed.

Press the green Start button. The printer scans all of the pages into a document, then sends the
document as an email attachment in .pdf or .tiff file format.
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Selecting Internet Fax Options

This section includes:
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Adjusting Brightness and Sharpness

You can lighten or darken the image, and adjust the sharpness.

To adjust the image:

1.
2.
3.

Touch the Services Home button, then touch Internet Fax.
Touch the Advanced Settings tab, then touch Image Options.
On the Image Options screen, adjust the sliders as needed:

— Lighten/Darken lightens or darkens the image.

—  Sharpness sharpens or softens the image.

Touch OK.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To select Auto Suppression:

1.

2
3.
4
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Touch the Services Home button, then touch Internet Fax.

Touch the Advanced Settings tab, then touch Image Enhancement.
Under Background Suppression, touch Auto Suppression.

Touch OK.
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Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. On the Image Enhancement screen, adjust the contrast:

—  Manual Contrast allows you to adjust the contrast manually. Move the slider up or down to
increase or decrease the contrast. The middle position on the slider, Normal, does not change
the contrast.

—  Auto Contrast allows the printer to set the contrast automatically.
4. Touch OK.

Setting the Resolution

1.  Touch the Services Home button, then touch Internet Fax.
2. Touch the Advanced Settings tab, then touch Resolution.
3. On the Resolution screen, touch the desired resolution.
— 72 dpi produces acceptable image quality for onscreen viewing, and the smallest file size.
— 100 dpi produces good image quality for onscreen viewing, and small file size.
— 150 dpi produces good image quality for onscreen viewing, and small file size.
— 200 x 100 dpi produces good image quality, and moderate file size.
— 200 dpi produces good image quality, and moderate file size. This setting is the default.
— 300 dpi produces high image quality, and large file size.
— 400 dpi produces higher image quality, and larger file size.
— 600 dpi produces the highest image quality, and the largest file size.
4. Touch OK.

Note: Check with the system administrator to determine the largest file size that the email system
allows.

Setting the Quality and File Size

The Quality/File Size option lets you choose from three settings that balance the quality of the image
and the size of the file. Higher quality images result in larger file sizes, which are not ideal for sharing and
transmitting over the network.

To set the Internet fax quality and file size:
1.  Touch the Services Home button, then touch Internet Fax.
2. Touch the Advanced Settings tab, then touch Quality/File Size.

3. On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal
Quality and Small File Size to Highest Quality and Largest File Size.

4. Touch OK.
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Specifying the Orientation of the Original

1.
2.
3.

Touch the Services Home button, then touch Internet Fax.
Touch the Layout Adjustment tab, then touch Original Orientation.
On the Original Orientation screen, touch the desired orientation:

— Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

—  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning it
over.

Touch OK.

Specifying the Size of the Original

To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:

1.
2.
3.

4,

Touch the Services Home button, then touch Internet Fax.

Touch the Layout Adjustment tab, then touch Original Size.

On the Original Size screen, select an option:

—  Auto Detect: This options allows the printer to determine the size of the original.

Note: The Auto Detect option is enabled only when the original is loaded in the duplex automatic
document feeder.

—  Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areq, touch the Length (Y) and Width (X) arrows.

Touch OK.

Adding a Message

1.

2.
3.
4

Touch the Services Home button, then touch Internet Fax.
Touch the Internet Fax Options tab, then touch Message.
Type a message using the touch screen keyboard.

Touch OK.

Specifying a Reply To Address

1.

2.
3.
4
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Touch the Services Home button, then touch Internet Fax.
Touch the Internet Fax Options tab, then touch Reply To.
Type an email address using the touch screen keyboard.
Touch OK.
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Printing an Acknowledgment Report

If the status of each recipient is known, you can print a delivery status report. The printer waits for a
delivery receipt from each recipient, then prints the report.

Note: The report could be delayed depending on the response time of the recipients.

To print an acknowledgment report:

1. Touch the Services Home button, then touch Internet Fax.

2. Touch the Internet Fax Options tab, then touch Acknowledgment Report.
3.  Touch Print Report.

4.  Touch OK.

Building a Fax Job

For details, see Building a Fax Job on page 152.
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Sending a LAN Fax

Local Area Network (LAN) Fax allows you to send faxes from the print driver on your computer to a fax
machine over a telephone line. The Fax window allows you to enter recipients, create a cover page with
notes, and set options. Using the options you can select confirmation sheets, send speed, fax resolution,
send time, and fax dialing options.

Notes:

e  When the Fax job type is selected, some features, such as Edge Enhancement, Thin Line
Enhancement, and Black Enhancement, are turned off.

¢ Not all printer models support this feature.

To send a LAN fax:

1. With the desired document or graphic open in your application, open the Print dialog box. For most
software applications, click File>Print or press CTRL+P.

Select your printer, then click Properties to open the print driver dialog box.
On the Paper/Output tab, from the Job Type list, select Fax.
Click Recipients.

- whN

Do one or more of the following:

—  Click the Phonebook button, select a phone book from the list, select a name from the upper
list, then add it to the Fax Recipients. Repeat the procedure to add more names. Click OK.

—  Click the Add Recipients button, type the recipient name and fax number, add other
information, then click OK. Add new recipients as needed.

6. Toinclude a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a
Cover Sheet.

7. On the Cover Sheet information tab, type notes that you want to appear on the cover sheet.
8. On the Options tab, select the options for this fax.

9. Click OK.

10. In the Printer Properties window, click OK.

11. In the Print window, click OK.

12. To confirm the recipients, click OK.
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Using the Address Book

This section includes:

Adding an Individual Entry to the Device Address BOOK .........o.orinririneenseensinsisessssssssssesssssssssssens 163
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Adding an Individual Entry to the Device Address Book

The Device Address Book can contain up to 5000 contacts. If the Add button is unavailable, the address
book has reached its limit.

Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch
Screen for All Users.

To add a recipient to the Device Address Book:

1.
2.
3.

L N

10.

11.

Press the Services Home button, then touch Email.
Touch New Recipient.

Touch the Enter email address and select Add field, then use the touch screen keyboard to type
the email address.

At the end of the address field, touch the Add to Address Book icon.
— Toadd the recipient to the address book, touch Create New Contact.

— Toadd the new recipient information to an existing address book contact, touch Add to
Existing Contact.

To add name and company information for the new entry, to the right of the contact field, touch
the i button.

a. Enter a name into the First Name, Last Name, or Company field, then touch OK.
Note: The first entry into one of the fields becomes the display name for the contact information.

b. Enter names into the remaining fields, then touch OK after each entry.

At the Additional Contact Information page, touch OK.

To enter a fax number for the contact, to the right of the green fax icon, touch the field.
Touch Enter Fax Number, use the alphanumeric keypad to enter the number, then touch OK.

To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the
field. Touch Enter Internet Fax Number, use the alphanumeric keypad to enter the number, then
touch OK.

To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

To save the contact to the Device Address Book, touch OK.
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To add a recipient to the Device Address Book using the Fax feature:

1.
2.

Press the Services Home button, then touch Fax.
Touch the Enter Fax Number field.
— Toadd the recipient to the address book, touch Create New Contact.

— To add the new recipient information to an existing address book contact, touch Add to
Existing Contact.

To add name and company information for the new entry, to the right of the contact field, touch
the i button.

a. Enter a name into the First Name, Last Name, or Company field, then touch OK.
Note: The first entry into one of the fields becomes the display name for the contact information.

b. Enter names into the remaining fields, then touch OK after each entry.

c. Atthe Additional Contact Information page, touch OK.

To add an email contact for the recipient, touch the field to the right of the email icon.
a. Touch Enter Email Address.

b. Enter a valid email address.

c¢. Touch OK.

To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the
field. Touch Enter Internet Fax Number, use the alphanumeric keypad to enter the number, then
touch OK.

To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

To save the contact to the Device Address Book, touch OK.

Editing an Individual Address Book Entry

mieswhNh-=

10.

164

Press the Services Home button, then touch Email.
Touch Address Book.

Under Names, touch a contact name.

Touch Details.

To change the display name of the contact, touch the i button, edit the information in the fields,
then touch OK.

To enter or change a fax number for the contact, to the right of the green fax icon, touch the field.
Touch Enter Fax Number, use the alphanumeric keypad to enter the number, then touch OK.

To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the
field. Touch Enter Internet Fax Number, use the alphanumeric keypad to enter the number, then
touch OK.

To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

To save the contact to the Device Address Book, touch OK.
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Editing or Deleting Favorites in the Device Address Book

ok wh~

Press the Services Home button, then touch Fax.

Touch Address Book.

Touch the Down arrow, then touch Contacts or All Contacts.
Touch the desired entry, using the scroll arrows as needed.
Touch Details.

To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax
fields, touch the corresponding star.

To delete a favorite, to the right of the global address book, fax, or Internet fax field, touch the
corresponding orange star.

Touch OK.
To return to the main menu, press the Services Menu button.

Printing a Fax Report

You can print the following fax reports from the printer control panel:

Activity Report

Protocol Report

Fax Address Book Report
Options Report

Pending Jobs Report

To print a fax report:

1.

m s whN

At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch Service Settings>Embedded Fax Settings.

Touch Print Fax Reports, then touch the arrows to scroll if needed.

Touch the desired report, then touch Print Now.

Touch Close, then log out.
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This chapter includes:
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Cleaning the Printer

This section includes:
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General Precautions

A

A

>
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CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting.
Do not touch or scratch the surface of the drum.

CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as
directed in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum
cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized
spray cleaners increases the risk of fire and explosion.

WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any maintenance
procedure that is not described in the documentation supplied with your printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

Do not place anything on top of the printer.

Do not leave the covers and doors open for any length of time, especially in well-lit places. Light
exposure can damage the drum cartridge.

Do not open covers and doors during printing.
Do not tilt the printer while it is in use.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Exterior

Clean the exterior of the printer once a month.
e  Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
e  After cleaning, wipe with a dry, soft cloth.

e  For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain
off.

/1, CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

Cleaning the Scanner

Xerox recommends that you clean the scanner about once a month or when vertical lines appear on
copies or scans from the automatic document feeder. Vertical lines appear when anything is spilled on
the scanner or when debris or dust collect on any of the surfaces. Clean scanner glass surfaces and feed
rollers ensure the best possible copies and scans.

Cleaning the Document Glass and Cover

1. Slightly dampen a soft, lint-free cloth with water.
2. Remove any paper from the duplex automatic document feeder.

3. Open the document cover.
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4.  Wipe the surfaces of the document glass and CVT glass until they are clean and dry.

Note: For best results, to remove marks and streaks, use a standard glass cleaner.

6. Close the document cover.
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Cleaning the Feed Rollers and Separation Pad on the Automatic Document Feeder

1. Open the duplex automatic document feeder top cover.

Note: If the duplex automatic document feeder feed rollers and separation pad get stained with
toner or debris, they can cause stains on the documents. To remove stains, use a soft lint-free cloth
dampened with a neutral detergent or water.

3. Close the document feeder top cover.

Cleaning the Interior

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer
regularly. Clean the printer interior whenever you replace the drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing
the printer covers and doors.

e Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 198.
e  Remove any dust or stains with a dry, clean cloth.

‘,i\_ WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the
printer has cooled.
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Cleaning the Laser Lenses

If prints have voids or light streaks through one or more colors, use the following instructions to clean the
laser lenses.

‘,i\_ WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out
immediately with cool water and consult a doctor.

1. Open the side door.

2. To unlock the waste cartridge, turn the waste cartridge lever 90-degrees counterclockwise.

172 Xerox® WorkCentre® 6655 Color Multifunction Printer
User Guide



Maintenance

3. Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the openings
facing up.

Notes:

e  Be careful not to spill toner when handling the waste cartridge.
e  After removing the waste cartridge, do not touch the area shown in the illustration.
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4. Place the removed waste cartridge on a level surface.

g

.

fi‘\ CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side.
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6. Insert the cleaning rod into one of the four cleaning holes until it clicks, then pull it out. Repeat this
two more times.

8
"

7. Repeat the procedure for the holes in the other three slots.
8. Return the cleaning rod to its original location.

9.

Note: If the waste cartridge does not fit into place properly, ensure that the belt is inserted fully.
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10. To lock the waste cartridge, turn the waste cartridge lock lever 90-degrees clockwise.

11. Close the side door.

Cleaning the Color Toner Density Sensors
1. Turn off the printer.

‘i\_ CAUTION: If the optional Productivity Kit (HD) is not installed, ensure that the Ready LED is off
before you turn off the printer. The data in the memory is cleared when the printer is turned off.

2. Push down on the rear door release and pull open the door.
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3. Open the side door.

4. To unlock the waste cartridge, turn the waste cartridge lever 90-degrees counterclockwise.
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5. Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the openings
facing up.
ISy
0 f]'
Notes:

e  Be careful not to spill toner when handling the waste cartridge.

e  After removing the waste cartridge, do not touch the area shown in the illustration.
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6. Place the removed waste cartridge on a level surface.

g

.

i‘\ CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side.

s;
3
A

RS
%

V]
i, 3
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Open the top cover.

8.

Y

Put your fingers through the loops on both sides of the transfer belt unit, then pull it out.

9.

10. Use a dry cotton swab to clean the color toner density sensors.
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11. Reinsert the belt unit into the printer.

12. Close the top cover.

Note: If the waste cartridge does not fit into place properly, ensure that the belt is inserted fully.
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14. To lock the waste cartridge, turn the waste cartridge lock lever 90-degrees clockwise.

15. Close the side door.
16. Close the rear door.

Maintenance
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Billing and Usage Information

Billing and printer usage information appears on the Billing Information screen. The impression counts
shown are used for billing.

To view Billing and Usage information:
1. At the printer control panel, press the Machine Status button.
2. To view basic impression counts, touch the Billing Information tab:

—  Black Impressions: Total number of pages printed with no color specified.

—  Color Impressions: Total number of pages printed that specify color.

—  Total Impressions: Total number of color impressions plus black impressions.
3. To view detailed usage information, touch Usage Counters, then select an option.
4. Toreturn to the Services Home menu, press the Services Home button.
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Ordering Supplies

This section includes:

®  WHEN £0 OFAEr SUPPLIES ...ttt cssisseesssssess s ssss s sssssssasssssssssssasesssssssssssssssssessssssssassassssssssesens 184
®  VieWING Printer SUPPLY SEALUS ...ttt sessisssassssssesssessssssssssssssssssssssssssssssssssssssssssssssssassssssssssnsans 184
O CONSUMADLES ...ttt e s s ee s s e s bbb e ssseessesaresanes 185
o ROULINGE MAINTENANCE TLEMIS ...ttt st s s s st s s sassesssssssesansnans 185
®  RECYCING SUPPLES ...ttt sss st s s b s bbb e s e s s s as b s s e s s s e b s s s s s s sens 185
O TONET COMIIAGES...ouiireeeieressessie ettt sse st sss bbb s s bss s s s s s et s bbb es bbb st s s ee b b s bas b sasn s s e 186
When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order these items when the messages first appear to avoid
interruptions to your printing. An error message appears on the control panel when supplies must be
replaced.

Order supplies from your local reseller or go to www.xerox.com/office/WC6655supplies.

A

CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement,
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance

caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Please contact your Xerox representative for details.

Viewing Printer Supply Status

You can check the status and percentage of life remaining for your printer supplies at any time using
CentreWare Internet Services or the control panel.

To view printer supply status using CentreWare Internet Services:

1.

184

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs.

Select the Status tab.
Under Status, click Supplies.
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To view printer supply status using the control panel:
1. At the control panel, press Machine Status, then touch the Supplies tab.

2. To view details about a specific cartridge, including the part number for reordering, touch C, M, Y,
or K.

To return to the Supplies tab, touch Close.
To view more details, touch Other Supplies, then select an option.
To return to the Other Supplies screen, touch Close.

o v bW

To return to the main screen, press Services Home.

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. Consumable
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.

Notes:

e Each consumable includes installation instructions.
e To ensure print quality, the toner cartridge has been designed to cease functioning at a
predetermined point.

& CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by
Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:
e Imaging Unit

e Transfer Unit Kit

e  Waste Cartridge

e Fuser

e Feed Roller Kit

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa.
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Toner Cartridges

This section includes:
O GONETAL PrOCOULIONS ettt eeteeestes s e tes s ses s ssasasssssssssasssesasassasassssasasssasassasassesesasasssasasssnns 186
o Replacing A TONET CArtFIAGE ... iseessissseseassssssssssssesssssssssesssssssssssssssssassssssssssssssssssssssasessessssssnsens 186

General Precautions

/A WARNINGS:
e  When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

e Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the
child spit out the toner, and rinse out their mouth with water. Consult a physician immediately.

o Use adamp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric
sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of
toner, contact your local Xerox representative.

o  Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch
fire and cause burn injuries or an explosion.

& WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any maintenance
procedure that is not described in the documentation supplied with your printer.

e Do not open covers and doors during printing.

e Do not leave the covers and doors open for any length of time, especially in well-lit places. Light
exposure can damage the drum cartridge.

e Do not place anything on top of the printer.
e Do not tilt the printer while it is in use.

e Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

e  Ensure any parts removed during cleaning are replaced before you plug in the printer.

Replacing a Toner Cartridge

When a toner cartridge reaches its usable life span, the control panel displays a message. Job Tracker
displays the toner status in the Printer Status window. When a toner cartridge is empty, the printer stops
and displays messages on the control panel and in the Job Tracker Printer Status window.

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining
amount displayed could be inaccurate.

Note: Each toner cartridge includes installation instructions.
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Moving the Printer

/1 WARNINGS:
e To lift the printer, always use at least two people to grasp the hand holds on each side of the
printer.

e To prevent dropping or tipping the printer, hold the printer between two people, with each
person using one hand underneath to hold the printer and the other hand on top to stabilize it.

o If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the
optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and
cause injury.

To move the printer:

1. Always turn off the printer and wait for the printer to shut down. For details, see Turning the Printer
On and Off on page 39.

2. Disconnect the power cord and other cables from the back of the printer.
WARNING: To prevent electric shock, never touch the power plug with wet hands. When removing

the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which
can lead to fire or electric shock.

3. Remove any paper or other media from the output tray. If the output tray extension is extended,
close it.
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4. Remove the paper from the paper tray.
Keep the paper wrapped and away from humidity and dirt.

5. When lifting the printer, grasp the areas as shown.

Notes:

e  When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right.
Tilting the printer more than 10 degrees can cause toner spillage.

e  When moving the printer over a long distance, remove the imaging units and toner cartridges
to prevent toner from spilling. Repack the printer and its options using the original packing
material and boxes or a Xerox Repackaging Kit. For a repacking kit and instructions, go to
www .xerox.com/office/WC6655support.

fi\. CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered
by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty,
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by
improper moving.
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After moving the printer:

1. Reinstall any parts you removed.

2. Reconnect the printer to the cables and power cord.
3. Plugin and turn on the printer.
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General Troubleshooting

This section includes:

) PriNTEI FOIS TO POWET O ettt e e et sesssas s e s st sasas s s s e s ssassetetessasasssasassetetesenesasasnens

o  Printer Resets or TUMNS Off FIEQUENTLY ........ovveververierers ettt s stsssessssssssssssssssssssssssssssssssnssssssssens
®  PrINEEI FALS £0 PriINT oottt ee s e ses s s s s e saees
®  Printing TAKES TOO LONG ...ttt sttt ssssssssssssssssesssssssssssssssssssasesssssesssesens
e  Document Prints From Wrong Tray
o Automatic 2-Sided Printing ProODIEMS ...ttt ssssssssssssssssssssssssssssssssssssssssssssssssssans
o Printer MaKes UNUSUGL NOISES ...ttt tssss st sassasssssassaessss s ses s s s s s s sssssassassassansanen
® PP TrAY FIS 0 ClOSE ...ttt stssssss s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssnsssnssans
e  Condensation Has Formed INSide the PriNTEr ... sssissessssss s sssessssssssssssssssssssssssssssens

This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Printer Fails to Power On

Probable Causes Solutions

One of the power switches is not turned on. Turn on both power switches. For details, see Turning the Printer On
and Off on page 39.

The power cord is not correctly plugged into | Turn off the printer power switch, and plug the power cord securely

the outlet. into the outlet. For details, see Turning the Printer On and Off on
page 39.

Something is wrong with the outlet e Plug another electrical appliance into the outlet and see if it

connected to the printer. operates properly.

e Try adifferent outlet.

The printer is connected to an outlet with a Use a power source with the specifications listed in the Electrical
voltage or frequency that does not match the | Specifications on page 232.
printer specifications.

.-‘i‘\ CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.
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Printer Resets or Turns Off Frequently

Probable Causes Solutions

The power cord is not plugged into the outlet
correctly.

Turn off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then turn on the printer.

A system error occurred.

Turn off the printer, then turn it on again. Print the Error History
from the Information Pages of the Printer Setting Utility. If the error
persists, contact your Xerox representative.

The printer is connected to an uninterruptible
power supply.

Turn off the printer, then connect the power cord to a suitable
outlet.

The printer is connected to a power strip
shared with other high-power devices.

Plug the printer directly into the outlet or into a power strip that is
not shared with other high-power devices.

Printer Fails to Print

Probable Causes Solutions

The printer has an error.

e To clear the error, follow the onscreen prompts.

e Turn off the printer, then turn it on again. If the error persists,
contact your Xerox representative.

The printer is out of paper.

Load paper into the tray.

A toner cartridge is empty.

Replace the empty toner cartridge.

The front door is open.

e Ensure that the toner cartridge and imaging unit are installed
and fully seated.

e Ensure that the door is closed completely.

e Turn off the printer, then turn it on again. If the error persists,
contact your Xerox representative.

The power cord is not correctly plugged into
the outlet.

Turn off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then turn on the printer. For
details, see Turning the Printer On and Off on page 39. If the error
persists, contact your Xerox representative.

The printer is busy.

e A previous print job could be the problem. On your computer,
you can use the printer properties to delete all print jobs in the
print queue.

e Load the paper in the tray.
e At the control panel, touch Job Status. If the print job does not

appear check the Ethernet connection between the printer and
the computer.

e At the control panel, touch Job Status. If the print job does not
appear, check the USB connection between the printer and the
computer. Turn off the printer, then turn it on again.
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Probable Causes

The printer cable is disconnected.

Solutions

e At the control panel, touch Job Status. If the print job does not
appear check the Ethernet connection between the printer and
the computer.

e At the control panel, touch Job Status. If the print job does not
appear, check the USB connection between the printer and the
computer. Turn off the printer, then turn it on again.

Printing Takes Too Long

Probable Causes

Solutions

The printer is set to a slower printing mode.
For example, the printer could be set to print
on Heavyweight paper.

It takes more time to print on certain types of special paper. Ensure
that the paper type is set properly in the driver and at the printer
control panel. For details, see Print Speed on page 233.

The printer is in Power Saver mode.

It takes time for printing to start when the printer is coming out of
Power Saver mode.

The way the printer was installed on the
network could be an issue.

Determine if a print spooler or a computer sharing the printer is
buffering all print jobs and then spooling them to the printer.
Spooling can slow print speeds. To test the speed of the printer,
print some information pages such as the Office Demo Page. If the
page prints at the rated speed of the printer, you could have a
network or printer installation issue. For additional help, contact the
system administrator.

The job is complex.

Wait. No action needed.

The print-quality mode in the driver is set to
Enhanced.

Change the print-quality mode in the print driver to Standard.

Document Prints From Wrong Tray

Probable Causes

Solutions

Application and print driver have conflicting
tray selections.

1. Check the tray selected in the print driver.

2. Go to the page setup or printer settings of the application from
which you are printing.

3. Set the paper source to match the tray selected in the print
driver or set the paper source to Automatically Select.

Note: To have the print driver select the tray, set the tray used as
the paper source to Auto Selection Enabled.
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Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for
2-sided printing. Envelopes and labels cannot be used for 2-sided
printing. For details, see Supported Standard Types and Weights for
Automatic 2-Sided Printing on page 55 and Supported Standard
Paper Sizes for Automatic 2-Sided Printing on page 54.

Incorrect setting. In the print driver Properties, select 2-Sided Print on the
Paper/Output tab.

Printer Makes Unusual Noises

Probable Causes Solutions
There is an obstruction or debris inside the Turn off the printer and remove the obstruction or debris. If you
printer. cannot remove it, contact your Xerox representative.

Paper Tray Fails to Close

Probable Causes Solutions

The paper tray does not close fully. e The paper tray lift plate is not locked down. Push down on the
paper stack at the back of the tray until it locks down.

o If the tray is extended for legal size paper, the tray protrudes
when it is inserted into the printer.

e Some debris or an object is blocking the tray.

o Adjust the paper guides in the tray to match the size of the
paper.

Condensation Has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85 % or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that
is heated quickly.

Probable Causes Solutions
The printer has been sitting in a cold room. e Allow the printer to acclimate for several hours before operation.
e Allow the printer to operate for several hours at room
temperature.

The relative humidity of the room is too high. |e Reduce the humidity in the room.

e Move the printer to a location where the temperature and
relative humidity are within the operating specifications.
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Paper Jams

This section includes:

®  LOCALING PAPEE JAMS...c. oottt iessesssisssessasssssssssssssssssssssssesssssssssssssesssasssssssssssssessssssssassssesssesssssssssssassssssssssans 196
®  MiNIMIZING PAPEI JAMS .ottt sttt sssssssssssssssssssssssssssasssesssssesssssssssssssssssssssssassasssnssnns 197
®  CleariNgG PAPEN JAMS......civeeieeerieesiesies s st sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssanssssssssassasssssssnssssssnssens 198
o TroubleshOOting PAPEI JAMS ...ttt ssss s s ssssss st sssssssssssssssssessssesssassssnns 209
®  Print-QUALILY PrODIEMS ...ttt sess st s e ssss b ssss s s s s st sss s s s s s b s s sssss b st b ssssassssnsans 211
®  COPY AN SCAN PrODBIEMIS......coereererierissiesrss st sesssss s sssstsssasssssssss s s sssssssssss s s st ssssssssssssassssssensenssans 217
O FOX PTODLEMIS.....c ettt s bRt 219

Locating Paper Jams

‘,i\. WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the
printer has cooled. If the error persists, contact your Xerox representative.

‘,i\. CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently
damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Optional Tray 4. Bypass Tray
2. Duplex Automatic Document Feeder 5. Tray 1
3. Fuser
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Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one areq, clean that area of the paper
path.

The following can cause paper jams:

Selecting the incorrect paper type in the print driver.
Using damaged paper.

Using unsupported paper.

Loading paper incorrectly.

Overfilling the tray.

Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:

Use only supported paper. For details, see Supported Paper on page 52.
Follow proper paper handling and loading techniques.

Always use clean, undamaged paper.

Avoid paper that is curled, torn, moist, creased, or folded.

To separate the sheets before loading into the tray, fan the paper.
Observe the paper tray fill line; never overfill the tray.

Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

After loading the trays, select the correct paper type and size on the control panel.
When printing, select the correct type and size in the print driver.

Store paper in a dry location.

Do not open sealed packages of paper until you are ready to load them into the printer.

Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture
loss or gain.

Avoid the following:

Polyester coated paper that is specially designed for inkjet printers.

Paper that is folded, wrinkled, or excessively curled.

Loading more than one type, size, or weight of paper in a tray at the same time.
Overfilling the trays.

Allowing the output tray to overfill.

For a detailed list of supported paper, go to www.xerox.com/paper.
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Troubleshooting

Clearing Paper Jams

This section includes:

e  Clearing Paper Jams from the Duplex Automatic Document Feeder ... nrrcnrinsrensiessensinsennnen.
o  Clearing Paper Jams from the BYPASS TIAY .....c.crrvrreerrrerreenreerssensensssnsssssssssssssssssssssssssssssssssssssssssssssssssssssnns
o  Clearing Paper Jams from the TraY 2 ATEQ ... eerereesieseensisssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns
o Clearing Paper JAmS from the FUSEE ATEa ......wrveverinrineinsisesesissesssssstsssssssssssssssssssssssssssssssssssssssssssssssssssens

Clearing Paper Jams from the Duplex Automatic Document Feeder

1. Remove the remaining paper from the duplex automatic document feeder.
2. Open the duplex automatic document feeder top cover.

illustrated.
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4. Toreset the interlock switch and clear the paper jam message, open and close the back door.

5. Reload the document in the duplex automatic document feeder, then adjust the guides against the
edges of the paper.
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Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel you must clear all paper from the paper path.
1. Remove any paper from the bypass tray.

2.

3. Pull out the tray until it stops.
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4. Toremove the tray, lift the front of it slightly, then pull it out of the printer.

5. Remove the jammed paper.

6.
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7. Insert tray 1 into the printer, then push it in all the way.

Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.

8. Insert the bypass tray back into the printer. Push the tray in all the way.

9. If the control panel prompts you, on the screen, verify the paper size and type.
a. Touch Size, then, for a standard paper size, touch an option.
b. Touch Type, then, for the paper type, touch an option.

10. Touch OK.
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Clearing Paper Jams from the Tray 2 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.
1. Pull out tray 2 until it stops.

2.
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3.  Remove any paper jammed at the front of the printer.

4,
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5. Insert tray 2 into the printer, then push it all the way in.

Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the
printer.
6. If the control panel prompts you, on the screen, verify the paper size and type.
a. Touch Size, then, for a standard paper size, touch an option.
b. Touch Type, then, for the paper type, touch an option.
c. Touch OK.
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Clearing Paper Jams from the Fuser Area

1. Push down on the rear door release and pull open the door.

2.

3.

206 Xerox® WorkCentre® 6655 Color Multifunction Printer
User Guide



Troubleshooting

4. Remove any jammed paper from the back of the printer.
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Remove any jammed paper from the back of the printer.

7.

Close the rear door.

8.
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Troubleshooting Paper Jams

This section includes:

e  Multiple Sheets Pulled Together .........

e  Paper Misfeeds

e Label and Envelope Misfeeds

e  Paper Jam Message Stays On..............
Jams During Automatic 2-Sided Printing

Multiple Sheets Pulled Together

Probable Causes

The paper tray is too full.

Troubleshooting

Solutions

Remove some of the paper. Do not load paper past the fill line.

The edges of the paper are not even.

Remove the paper, align the edges, and then reload it.

The paper is moist from humidity.

Remove the paper from the tray, then replace it with new dry paper.

Too much static electricity is present.

Try a new ream of paper.

Unsupported paper is in the tray.

Use only Xerox approved paper. For details, see Supported Paper on
page 52.

Humidity is too high for coated paper.

o Feed paper one sheet at a time.
e Fan paper before loading it in the paper tray.

Paper Misfeeds

Probable Causes Solutions

The paper is not correctly positioned in the
tray.

e Remove the misfed paper and reposition it properly in the tray.
e Adjust the paper guides in the tray to match the size of the
paper.

The paper tray is too full.

Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly adjusted
to the paper size.

Adjust the paper guides in the tray to match the size of the paper.

The tray contains warped or wrinkled paper.

Remove the paper, smooth it out, and reload it. If it still misfeeds,
do not use that paper.

The paper is moist from humidity.

Remove the moist paper and replace it with new, dry paper.

Using paper of the wrong size, thickness, or
type.

Use only Xerox approved paper. For details, see Supported Paper on
page 52.
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Label and Envelope Misfeeds

Probable Causes

Solutions

The label sheet is facing the wrong way in the
tray.

e Load label sheets according to the instructions from the
manufacturer.

e Load labels in the tray, face up.
For details, see Labels.

Labels are missing, curled, or pulled away
from the backing sheet.

Do not use any sheet where labels are missing, curled, or pulled
away from the backing sheet.

Envelopes are loaded incorrectly.

Load envelopes in the bypass tray only.
For details, see Loading Envelopes in the Bypass Tray on page 63.

Envelopes are wrinkling.

e The heat and pressure of the laser printing process can cause
wrinkling.

e Use supported envelopes. For details, see Guidelines for Printing
Envelopes on page 62.

Paper Jam Message Stays On

Probable Causes

Solutions

Some paper remains jammed in the printer.

Recheck the media path and ensure that you have removed all of
the jammed paper.

One of the printer doors is open.

Check the doors on the printer and close any door that is open.

The rear door interlock switch is not reset.

To reset the interlock switch and clear the paper jam message, open
and close the back door.

Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

Probable Causes

Solutions

Using paper of the wrong size, thickness, or
type.

Use paper of the correct size, thickness, or type. For details, see
Supported Paper Sizes for Automatic 2-Sided Printing on page 54.

Paper is loaded in the wrong tray.

The paper must be loaded in the correct tray. For details, see
Supported Paper on page 52.

Tray is loaded with mixed paper.

Load the tray with only one type and size of paper.
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Troubleshooting

Print-Quality Problems

This section includes:
o Controlling Print QUALILY ...ccucveereeeeiesiesiestessc st sestssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssnssens 211
o Solving Print-QUality PrODIEMIS. ...ttt ssssssss s s s sss et sssssssessssssasessnsnns 212

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems,
use the information in this section to troubleshoot the problem. For more information, go to
www.xerox.com/office/WC6655support.

.-‘i‘\ CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Please contact your local representative for details.

Note: To ensure consistent print quality, the toner cartridges and imaging units for many models of
equipment are designed to cease functioning at a predetermined point.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this
section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal
print quality is: 15-28°C (59-82°F) and 20-70 % relative humidity.
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Troubleshooting

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section
for the best print quality and to avoid jams:

e  Use only Xerox approved paper. For details, see Supported Paper on page 52.
e Use only dry, undamaged paper.

‘i\_ CAUTION: Some paper and other media types can cause poor output quality, increased paper jams,

or damage your printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

o Non-laser glossy or coated paper

e Paper that has been photocopied

e Paper that has been folded or wrinkled

e Paper with cutouts or perforations

e Stapled paper

o Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Ensure the paper type selected in your print driver matches the paper type on which you are
printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

e  Store your paper and other media properly for optimum print quality. For details, see Paper Storage
Guidelines on page 53.

Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and see the
corresponding solution to correct the problem. You can also print a Demo Page to more precisely
determine the print-quality problem. For details, see Information Pages on page 25.

If the print quality does not improve after carrying out the appropriate action, contact your Xerox
representative.

Notes:

e To enhance print quality, toner cartridges for many models of equipment have been designed
to cease functioning at a predetermined point.

e  Grayscale images printed with the composite black setting increment the color pages counter,
because color consumables are used. Composite black is the default setting on most printers.
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Symptom

Faded printouts with multiple
colors faded
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Cause

The paper type is heavier or
thicker than the paper type
selection.

Troubleshooting

Solution

Adjust the paper type settings.

The paper being used is outside
the recommended specification
range.

Replace the paper with a
recommended size and type, and
confirm that your control panel and
print driver settings are correct. For
details, see Supported Paper on page
52.

The toner cartridges are not
Xerox® toner cartridges.

Replace the toner cartridges with
genuine Xerox® toner cartridges. It can
take several prints before full quality is
restored.

The bias transfer roller voltage is
insufficient for the paper type.

Verify that the paper loaded in the tray
matches the paper type selected at the
control panel and in the print driver.

The settings in the application or
print driver are incorrect.

Print the Graphics Demo Page. If the
Demo Page looks correct, the printer is
printing properly. Your application or
incorrect settings in the print driver are
probably causing the print-quality
problems.

The paper is damp.

Replace the paper.

Note: Store your paper and other
media properly for optimum print
quality. For details, see Paper Storage
Guidelines on page 53.

Only one color is faded

The toner cartridges are not
Xerox® toner cartridges.

Replace the toner cartridges with
genuine Xerox® toner cartridges. It can
take several prints before full quality is
restored.

The imaging unit is defective.

If the defect occurs in one color only,
replace the corresponding imaging
unit.
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Symptom

Copy colors are the wrong color

Cause

The color balance is not adjusted
properly.

Solution

Adjust the color balance.

1. At the printer control panel,
press the Machine Status
button.

2. Touch Tools>Service Settings.

3. Touch Feature
Defaults>Image
Quality>Color Balance.

4, Select a color, then adjust the
highlights, midtones, and
shadows.

5. Touch Save.

6. Touch Save Defaults.

7. Toreturn to the Services Home

menu, press the Services
Home button.

Stray black dots, white areas, or
dropouts

The paper is outside the
recommended specification
range.

Replace the paper with a
recommended size and type, and
confirm that your control panel and
print driver settings are correct. For
details, see Supported Paper on page
52.

The toner cartridges are not
Xerox® toner cartridges.

Replace the toner cartridges with
genuine Xerox® toner cartridges. For
details, see Consumables on page 185.

There is debris on the transfer
roller.

Wipe the transfer roller with a clean,
lint-free cloth moistened with water.

Note: Do not touch the transfer roller
or the exposed end of the transfer belt.

e Vertical black or color streaks
or multiple colored streaks or
lines

e Streaks in one color only

The toner cartridges are not
Xerox® toner cartridges.

Replace the toner cartridges with
genuine Xerox® toner cartridges. For
details, see Consumables on page 185.
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Symptom

Cause

The imaging unit is defective.

Troubleshooting

Solution

If the defect occurs in one color only,
replace the corresponding imaging
unit.

Debris in the printer is dragging
against the toner before the
toner is fused.

Remove any paper or debris from the
paper path.

Streaks in multiple colors

There is debris in the transfer belt
unit.

Inspect and clean or replace the
transfer belt unit.

Offset image

Image is printed a second time.

o Verify that the paper you are using
is the correct type for the printer
and is loaded properly. For details,
see Supported Paper on page 52.

o Verify that the paper loaded in the
tray matches the paper type
selected at the control panel and in
the print driver.

To verify paper type at the control
panel, press Machine Status, then
touch Machine Information>Paper
Tray Status.

Note: If the problem continues, select
the next lighter paper type.

e For uncoated paper, the papers
from lightest to heaviest are Plain,
Lightweight Cardstock, and
Cardstock.

e For coated paper, the papers from
lighter to heavier are Lightweight
Glossy Cardstock and Glossy
Cardstock.

Colors align incorrectly

Color has shifted outside the
designated area.

To initiate the color registration cycle,
open and close the rear door.
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Symptom

White lines or streaks running
through one color only

Cause

Something is blocking the lens for
the affected color.

Solution

Clean the lens for the affected color.

The toner cartridges are not
Xerox® toner cartridges.

Replace the toner cartridges with
genuine Xerox® toner cartridges. For
details, see Consumables on page 185.

The toner was stored in a high
temperature area.

Replace the toner cartridge.

White line or lines running
through all colors

Paper or debris is dragging
against the bottom of the
transfer belt unit.

e Remove any paper or debris from
the paper path.

o Replace the transfer belt unit.

e For assistance, go to the Xerox®
Support website at
www.xerox.com/office/WC6655sup
port.

Slanted printing

The paper guides are not set
correctly.

Reset the paper tray guides. For details,
see Loading Paper on page 56.

Incomplete fusing

Toner appears to be missing from
the print or is easy to rub off.

o Verify that the paper you are using
is the correct type for the printer
and is loaded properly.

o Verify that the paper loaded in the
tray matches the paper type
selected at the control panel and in
the print driver.

o Set the paper type to one type
heavier.
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Troubleshooting

Symptom Cause Solution

To verify paper type at the control
panel, press Machine Status, then
touch Machine Information>Paper
Tray Status. For more information
about paper weights, see the Offset
image section of this table.

Partial blanks, creased paper, or | The paper is damp. Replace the paper.

blotted printing The paper is outside the Replace the paper with a
recommended specification recommended size and type, and
range. confirm that your control panel and

print driver settings are correct. For
details, see Supported Paper on page
52.

Condensation inside the printer [ Turn on the printer and leave it on for
causes partial blanks or creased | at least one hour remove the

paper. condensation. For assistance, go to the
Xerox® Support website at
www.xerox.com/office/WC6655suppor

t.
The toner cartridges are not Replace the toner cartridges with
Xerox® toner cartridges. genuine Xerox® toner cartridges. For

details, see Consumables on page 185.
The paper is impeded in the e Remove any paper or debris from
paper path. the paper path.

e Ensure that the paper trays are

closed.

e Ensure that the rear cover is closed
and locked.

Copy and Scan Problems

If the copy or scan quality is poor, refer to the following table.
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Troubleshooting

Symptoms Solutions

Lines or streaks present in copies only made | There is debris on the document glass. When scanning, the paper
from the document feeder. from the document feeder passes over the debris creating lines or
streaks. Clean all glass surfaces with a lint-free cloth.

Spots present in copies taken from the There is debris on the document glass. When scanning, the debris
document glass. creates a spot on the image. Clean all glass surfaces with a lint-free
cloth.

The reverse side of the original is showing on | Turn on Background Suppression.
the copy or scan.

Image is too light or too dark. e Copy: To lighten, darken, or adjust contrast, use the Image
Quality settings.

e Scan: To lighten, darken, or adjust contrast, use the Advanced
Settings Tab.

If the problem persists, for online support information, go to www.xerox.com/office/WC6655support.
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Fax Problems

This section includes:
e  Problems Sending Faxes

e  Problems Receiving Faxes
e Selecting the Starting Rate

Troubleshooting

Note: If you cannot send and receive faxes, make sure that you are connected to an approved
analog telephone line. The fax cannot send or receive when connected to a digital phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

Problems Sending Faxes

Symptoms

The document is not scanned
using the document feeder.

Causes

The document is too thick, too thin, or
too small.

Solutions

Use the document glass to send the
fax.

The document is scanned at an
angle.

The document feeder guides are not
adjusted to the width of the document.

Adjust the document feeder guides to
fit the width of the document.

The fax received by the recipient
is blurry.

The document is incorrectly positioned.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too light.

Adjust the resolution. Adjust the
contrast.

There is a problem with the telephone
connection.

Verify that the telephone line is
working, then send the fax again.

There is a problem with the fax
machine of the caller.

Make a copy to verify that your printer
is operating correctly. If the copy was
printed correctly, have the recipient
verify the condition of their fax
machine.

The fax received by the recipient
is blank.

The document was loaded incorrectly.

e Document feeder: Place the original
document face up.

e Document glass: Place the original
document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.

The telephone line is incorrectly
connected.

Verify the telephone line connection. If
it is disconnected, connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax is not installed or is not
enabled.

Verify that the fax is installed and
enabled.

Server Fax is enabled.

Make sure that Server Fax is disabled.

If the problem persists, for online support information, go to www.xerox.com/office/WC6655support.
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Troubleshooting

Problems Receiving Faxes

Symptoms

The received fax is blank.

Causes

There is a problem with the telephone
connection or with the fax machine of
the caller.

Solutions

Verify that the printer can make clean
copies. If it can, have the caller send
the fax again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call, but
does not accept incoming data.

Not enough memory.

If the job contains several graphics, the
printer could not have enough memory.
The printer does not answer when
memory is low. Delete stored
documents and jobs then wait for the
existing job to complete. This increases
available memory.

The received fax size is reduced.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the
documents. Documents could be
reduced based on the available paper
supply in the printer.

Faxes cannot be received
automatically.

The printer is set to receive faxes
manually.

Set the printer to automatic reception.

The memory is full.

Load paper if it is empty, and then
print the faxes stored in the memory.

The telephone line is incorrectly
connected.

Verify the telephone line connection. If
it is disconnected, connect it.

There is a problem with the fax
machine of the sender.

Make a copy to verify that your printer
is operating correctly. If the copy prints
correctly, have the recipient verify their
fax machine is operating correctly.

If the problem persists, for online support information, go to www.xerox.com/office/WC6655support.

Selecting the Starting Rate

Select the highest starting rate unless the destination for the fax you are sending has special

requirements.

To select the transmission speed for a fax:
1.  Press the Services Home button, then touch Fax.
Touch the Fax Options tab, then touch Starting Rate.

2
3. Touch an option.
4. Touch OK.

Note: Some telephone networks can require you to set the fax starting rate to Forced (4800 bps).
The slower data rate ensures a more reliable transmission of data.
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Troubleshooting

Getting Help

This section includes:

®  CONLIOL PANEL MESSUQGES ..ot aessssssssssssssse s ssssssssssssasssssassssssssssessesssssssssssssssssesssssssassasssnssssssans 221
e  Using the Integrated TroubleShOOtiNG TOOLS ... issessssestessssessssssssssesssassssssessssssans 222
®  ONlINE SUPPOIT ASSISLAUNT......ecverieereeriesierisnsessies st sesssssstsssssssssssssssssss s sessssssssssssssssssssssssssssassssssssssssssssesssssssnssnsans 223
®  MOTE INTOIMOLION oottt sss s s sss s st s s s bbb s ssnssnes 223

Your printer comes with utilities and resources to help you troubleshoot printing problems.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning
condition occurs, the control panel displays a message informing you of the problem. For many status
and warning messages, the control panel Information provides additional information.

Control Panel Help

When a fault occurs that stops the printing operation, such as a paper jam, a message appears on the
screen. A graphical illustration appears to indicate the location of the fault with a brief explanation of
the action to take to clear the fault. The illustration changes to indicate multiple locations and actions to
take.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, a message appears on the control panel to inform you of the problem.
Warning messages inform you about printer conditions, such as low supplies or open doors, that require
your attention. If more than one warning condition occurs, only one is displayed on the control panel.

Viewing Current Faults on the Control Panel
When a fault condition occurs, a message appears on the control panel to inform you of the problem.

Fault messages warn you about printer conditions that prevent the printer from printing or degrade
printing performance. If more than one fault occurs, only one is displayed on the control panel.
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Troubleshooting

Viewing Job Status on the Control Panel

To view current or saved jobs on the control panel:

1.

LA

At the control panel, press the Job Status button.

To view a list of active jobs, touch Active Jobs.

To view a list of completed jobs, touch Completed Jobs.

To view a list of secure prints, touch Secure Print Jobs.

To view a list of secure faxes received, touch Secure Fax Receive.

Using the Integrated Troubleshooting Tools

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can
help with troubleshooting certain problems. The Demo Page prints an image using many colors to show
the current ability of the printer to print. The Error History report prints information on the most recent
printer errors.

Starting a Customer Self-Help Session

If your printer displays an error message that you cannot clear, you can connect the printer remotely to
a Xerox troubleshooting server. The troubleshooting server analyzes diagnostic information from your
printer and provides you with helpful solutions.

To start a remote troubleshooting session:

1.

2.
3.
4
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In your open application, select File>Print>Printer Properties.
Click More Status.

In the Customer Self-Help window, click Troubleshooting.
Follow the directions provided.
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Printing Reports

Troubleshooting

1. Atthe printer control panel, press the Machine Status button.
2. Touch Information Pages.

3. Use the arrows to navigate, then select a report.

4.  Touch Print.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to

solve your printer problems. You can find solutions for print-quality problems, paper jams, software

installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/WC6655support.

More Information

You can obtain more information about your printer from these sources:

Resource Location

Installation Guide

Packaged with the printer.

Other documentation for your printer

www.xerox.com/office/WC6655docs

Recommended Media List

United States: www.xerox.com/paper
European Union: www.xerox.com/europaper

Technical support information for your printer;
including online technical support, Online Support
Assistant, and driver downloads.

www.xerox.com/office/WC6655support

Information Pages

Print from the control panel, or from CentreWare
Internet Services, click Status>Information Pages.

CentreWare Internet Services documentation

In CentreWare Internet Services, click Help.

Order supplies for your printer

www.xerox.com/office/WC6655supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful tips,
and customized features to meet your individual
needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center

www.xerox.com/office/worldcontacts

Printer registration

www.xerox.com/office/register

Xerox® Direct online store

www.direct.xerox.com/
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Specifications

Printer Configurations and Options

Available Configuration

Network printer with copy, automatic 2-sided printing, scan, and fax functions, and USB or network

connectivity.

Standard Features

The printer provides the following features:

Print speed

Standard mode: Up to 36 ppm for Letter and 35 ppm for A4

2-Sided print speed

Standard mode: Up to 24 ppm for Letter and 23 ppm for A4.

Functions

Copy, scan, print, and fax

Note: Not all options listed are supported on all printers. Some options
apply only to a specific printer model, configuration, operating system,
or driver type.

Standard memory

e 4GB Device Memory
e Internal 160 GB hard drive

Print resolution

e Standard print-quality mode: 600 x 600 dpi
e High-Resolution print-quality mode: 2400 x 600 dpi

2-Sided Printing

Up to 163 g/m2 from any tray

Maximum print size

Legal (216 x 356 mm, 8.5 x 14in.)

Paper capacity

e Bypass Tray: 150 sheets
e Tray 1: 550 sheets
e Optional 550-Sheet Feeder

Copy speed

e 1-sided copy: 36 cpm
e 2-sided copy: 24 cpm

Copy resolution

600 x 600 dpi

Maximum copy size

Legal (216 x 356 mm, 8.5 x 14in.)

Document feeder

Duplex Automatic Document Feeder

Document feeder capacity

60 sheets

Scan resolution

e Optical: 600 x 600 dpi
e TWAIN: Up to 9600 dpi interpolated
o  WIA: Up to 600 dpi

Maximum scan size

e Document Glass: 215.9 x 355.6 mm (8.5 x 14 in.)
o Duplex Automatic Document Feeder: 215.9 x 355.6 mm (8.5 x 14in.)
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Specifications

Supported scanning e Scanto SMB

e ScantoFTP

e Scan to Email

e Scanto USB

e Scan to Computer (USB)

e WSD Scan
File formats o JPEG

o TIFF

e PDF
Control panel 7.0-inch LCD touch screen and keypad navigation
Connectivity e Universal Serial Bus (USB 2.0)

e USB Flash drive
e FEthernet 10/100/1000Base-T

Remote access CentreWare Internet Services

Options and Upgrades

e  Wireless network adapter
e  550-Sheet Feeder

Note: You can install a maximum of one optional tray on this printer.

e  Printer Stand
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Specifications

Physical Specifications

Weights and Dimensions

Standard Configuration Standard Configuration with Optional
550-Sheet Feeder
Width 53.8cm (21.2iin) 53.8cm (21.2in.)
Depth 55.3cm (21.8in.) 55.3cm (21.8in.)
Height 62.5cm (24.6 in.) 76.3cm (30.0in.)
Weight 37.6 kg (829 Ib.) 43.9 kg (96.8 Ib.)

Standard Configuration Physical Specifications

62.5cm
246in
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Specifications

Physical Specifications with Optional 550-Sheet Feeder

76.3 cm
30.0in

Clearance Requirements

94.5 cm
15.7in 37.2in
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Specifications

Clearance Requirements with Optional 550-Sheet Feeder

108.3 cm
426 in

1553 cm
61.1in

230 Xerox® WorkCentre® 6655 Color Multifunction Printer
User Guide



Specifications

Environmental Specifications

Temperature

e  Operating temperature: 5-32°C (41-90°F)
e  Optimum temperature: 15-28°C (59-82°F)

Relative Humidity

e  Minimum-Maximum Humidity Range: 10-85 %
e  Optimal Humidity Range: 20-70 % relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C and 85 % relative humidity, defects
can occur due to condensation.

Elevation

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).

Xerox® WorkCentre® 6655 Color Multifunction Printer 231
User Guide



Specifications

Electrical Specifications

Power Supply Voltage and Frequency

Power Supply Voltage Power Supply Frequency
100-127 VAC +/-10%, (90-140 VAQC) 50Hz +/-3 Hz

60 Hz +/- 3 Hz
220-240 VAC +/-10%, (198-264 VAQC) 50Hz +/-3 Hz

60 Hz +/- 3 Hz

Power Consumption

e  Power Saver Mode (Sleep): 2.7 W
e Ready, with fuseron: 71 W
e  Continuous printing: 565 W

This printer does not consume electric power when the main power switch is turned off even if the
printer is connected to an AC outlet.

ENERGY STAR Qualified Product

The Xerox® WorkCentre® 6655 Color Multifunction Printer is ENERGY STAR® qualified
under the ENERGY STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment industry
to promote energy-efficient copiers, printers, fax, multifunction printers, personal

computers, and monitors. Reducing product energy consumption helps combat smog,
acid rain, and long-term changes to the climate by decreasing the emissions that result
from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Power Saver modes after 2 minutes
from the last copy or print.
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Specifications

Performance Specifications

Power on: Approximately 4 minutes.

Print Speed

Maximum print speeds for 1-sided continuous printing on Plain media are 36 ppm for Letter (8.5 x 11 in.)
and 35 ppm for A4 (210 x 297 mm). Print speed slows with larger and heavier media.
Note: Print speeds are the same for Standard print-quality mode and High-Resolution print-quality
mode.

Several factors affect print speed:
e  Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.

e  2-sided printing: The maximum print speeds for 2-sided continuous printing are 24 ppm for Letter
(8.5x11in.) and 23 ppm for A4 (210 x 297 mm).

e Papersize. Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. Larger
sizes reduce print speeds.
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Regulatory Information

This appendix includes:

Basic Regulations ...,

Copy Regulations
Fax Regulations
Material Safety Data Sheets.................
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance
with these instructions, it may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e  Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to
operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.
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European Union

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with
c € the following applicable Directives of the European Union as of the dates indicated:

e December 12, 2006: Low Voltage Directive 2006/95/EC
e  December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC
e  March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for
the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

European Union Lot 4 Imaging Equipment Agreement Environmental
Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e  Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute

Introduction

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute
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Regulatory Information

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of
install. Continuing to use the duplex function will reduce the environmental impact of your work.
However, should you require simplex/1-sided printing, you may change the print settings in the print
driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m?), which contains less raw material and thus save resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and
models qualified to ENERGY STAR can be found at the following website:
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ

Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is
designed and configured to enable you to reduce your electricity costs. After the last print, the device
switches to Ready mode. In this mode, the device can print again immediately. If the product is not used
for a period of time, the device switches to a Power Saver mode. In these modes, to enable reduced
product power consumption, only essential functions remain active.

The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in
Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of
most imaging products on the market.

You can set a longer activation time or completely deactivate the Power Saver mode. This device can
take longer to switch to a lower energy level.

To learn more about Xerox participation in sustainability initiatives, go to:
www.xerox.com/about-xerox/environment/enus.html.
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Regulatory Information

Environmental Choice Certified to Office Machines CCD-035

This product is certified to Environmental Choice standard for office machines, meeting
all requirements for reduced environmental impact. As part of achieving certification,
o Xerox Corporation has proven this product meets the Environmental Choice criteria for

f’ % energy efficiency. Certified copier, printer, multifunctional device, and fax products

) s must also meet criteria such as reduced chemical emissions and demonstrate

A%% .bvoe? compatibility with recycled supplies. Environmental Choice was established in 1988 to

- help consumers find products and services with reduced environmental impacts.
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based environmental
certification. This certification indicates that a product has undergone rigorous
scientific testing, exhaustive auditing, or both, to prove its compliance with stringent,
third-party, environmental performance standards.
Germany

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device
the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies
Blue Angel criteria for environmental acceptability in terms of device design,
manufacture, and operation. For more information, go to: www.blauer-engel.de.

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um stérende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht
im unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenldrminformations-Verordnung 3. GPSGV: Der hochste Schalldruckpegel betrdgt 70 dB(A) oder
weniger gemdf EN ISO 7779.

Importeur
Xerox GmbH
HellersbergstrafBe 2-4
41460 Neuss

Deutschland
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Regulatory Information

Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yonetmeligine uygundur.”

Regulatory Information for 2.4 GHz Wireless Network Adapter

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive
99/5/EC.

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the
user's authority to operate this equipment.
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Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:
—  Certificates of Indebtedness.
—  National Bank Currency.
—  Coupons from Bonds.
—  Federal Reserve Bank Notes.
—  Silver Certificates.
—  Gold Certificates.
—  United States Bonds.
—  Treasury Notes.
—  Federal Reserve Notes.
—  Fractional Notes.
—  Certificates of Deposit.
—  Paper Money.
— Bonds and Obligations of certain agencies of the government, such as FHA and so on.

— Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

— Internal Revenue Stamps. If it is necessary to reproduce a legal document on which thereis a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

—  Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

—  Postal Money Orders.
—  Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

—  Stamps and other representatives of value, of whatever denomination, which have been or
may be issued under any Act of Congress.
— Adjusted Compensation Certificates for Veterans of the World Wars.
2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.

Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

Passports. Foreign Passports may be photographed.
Immigration papers.
Draft Registration Cards.

©® No W

Selective Service Induction papers that bear any of the following Registrant’s information:
—  Earnings or Income.

—  Court Record.

—  Physical or mental condition.

—  Dependency Status.

—  Previous military service.

—  Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the
head of such department or bureau).

Reproducing the following is also prohibited in certain states:
e  Automobile Licenses.

e  Drivers’ Licenses.

e  Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case
of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

e  Current bank notes or current paper money

e Obligations or securities of a government or bank

e  Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of
a court of law

e Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer
for a province)

e  Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a
province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada
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Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested,
this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack
that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0).
To be certain of the number of devices that can be connected to a line, as determined by the RENS,
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately
shown on the label.
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To order the correct service from the local Telephone Company, you could also have to quote the codes
in the following list:

e  Facility Interface Code (FIC) = 02LS2
e  Service Order Code (SOC) = 9.0Y

& CAUTION: Ask your local Telephone Company for the modular jack type installed on your line.
Connecting this machine to an unauthorized jack can damage telephone company equipment. You,
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this
machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the
Telephone Company interrupts your service, they can advise you of your right to file a complaint with
the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects the
operation of the equipment, they should notify you in order for you to make necessary modifications to
maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for
repair or warranty information. Contact information is contained in the Machine Status menu on the
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing
harm to the telephone network, the Telephone Company may request you to disconnect the equipment
until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If
unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state
tariffs. Contact the state public utility commission, public service commission, or corporation commission
for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that
the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a
qualified installer.
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Canada
This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or
alterations made by the user to this device, or device malfunctions, could cause the telecommunications
company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected
together. This precaution could be vital in rural areas.

fi‘\ WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric
inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals
allowed to be connected to a telephone interface. The termination on an interface could consist of any
combination of devices. The only limitation to the number of devices is the requirement that the sum of
the RENSs of the devices does not exceed 5. For the Canadian REN value, please see the label on the
equipment.

European Union

Radio Equipment and Telecommunications Terminal Equipment Directive

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European
single terminal connection to the public switched telephone network (PSTN). However, due to differences
between the individual PSTNs provided in different countries, the approval does not give an
unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal
equipment for use on analog-switched telephone networks in the European Economic Area. This product
provides a user-adjustable setting of the country code. The country code should be set prior to
connecting this product to the network. Refer to the customer documentation for the procedure for
setting the country code.

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we
recommend that you set it to use DTMF signaling for more reliable and faster call setup.
Modification of this product, connection to external control software, or connection to an external
control apparatus not authorized by Xerox® will invalidate its certification.

South Africa

This modem must be used in conjunction with an approved surge protection device.
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New Zealand

1.

N

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It indicates
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it
provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such
circumstances.

Immediately disconnect this equipment should it become physically damaged, then arrange for its
disposal or repair.

This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is
no guarantee that Telecom lines will always continue to support pulse dialing.

Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems,
do not contact the Telecom Faults Service.

DTMEF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

WARNING: No "111" or other calls can be made from this device during a mains power failure.

This equipment may not provide for the effective hand-over of a call to another device connected
to the same line.

Some parameters required for compliance with Telecom Telepermit requirements are dependent on
the equipment (computer) associated with this device. The associated equipment shall be set to
operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

—  There shall be no more than 10 call attempts to the same number within any 30 minute period
for any single manual call initiation, and

—  The equipment shall go on-hook for a period of not less than 30 seconds between the end of
one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that

there is no less than five seconds between the end of one call attempt and the beginning of
another.

For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.
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Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:
e  North America: www.xerox.com/msds
e  European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
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Recycling and Disposal

This appendix includes:

All Countries...................

North America
European Union
Other Countries.................
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All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable at
the time that the product was placed on the market. For recycling and disposal information, contact your
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply, please see
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal
information, contact your local authorities.
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Recycling and Disposal

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you
should not dispose of the equipment in the normal household waste
stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to take
back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you
must dispose of this equipment in compliance with agreed national
procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.
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Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents
mean that used electrical and electronic products and batteries should
not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used
batteries, please take them to applicable collection points, in
accordance with your national legislation and the Directive
2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to
save valuable resources and prevent any potential negative effects on
human health and the environment which could otherwise arise from
inappropriate waste handling.

For more information about collection and recycling of old products
and batteries, please contact your local municipality, your waste
disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in
accordance with national legislation.

Business Users in the European Union
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for

further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical
symbol. This establishes compliance with the requirements set out by
the Directive.

Hg

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
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Other Countries

Please contact your local waste management authority to request disposal guidance.
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